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Preface

AutoMax Ladder Editor Feature Overview

The AutoMax Ladder Editor ships as part of the AutoMax

Programming Executive. It can be run from within the Executive or
as a stand-alone application for offline programming only. The Editor

provides these features to help you create your ladder programs:

Moreeasily view and work with rungsin the same program orin
different programs.

Becausethe Editor is based on Microsoft Windows 95™, you can:

e Use familiar menu commandsand toolbariconsfor typical

Windowsfeatureslike restore, maximize, open, save, cut, copy,

and more

e Display multiple rungs at the sametime

e Display rungs from different parts of the program at the same

time

e Display rungs from more than one program at the sametime

e Use pop-up menusto access frequently used commands

Moreeasily edit ladder programs.

Becauseof the drag-and-drop functionality and property sheets for

each program element you can:

e Cut, copy, paste individual instructions and rungs or groupsof

instructions and rungs

e@ Move rungs by selecting them and dragging them with the

mouse

e Create a “work-in-progress program”by building rungs without

variable namesor coils when you end an editing session

e Insert instructions and branches, or change aninstruction type or

variable name without anyre-typing

e@ Reduce the amountof typing by importing the variable

descriptions for global variables from the Variable Configurator.

Also, while entering variable names, you can choosefrom list of

smart-matched names

e Insert new rungs without renumbering existing rungs

e Add rung descriptions which becomepart of the rung

Create programsusing an enhancedsetof ladderinstructions.

The AutoMax Ladder language has been enhancedto include

supportfor:

e An expandedinstruction set based on the IEC-1131-3 standard

e Variable names of up to 16 characters

e@ Multiple coils per rung

e@ More instructions per rung and more parallel branches

e Easier accessto bits within integers and arrays, for example:

INPUT_VAR.31 or array_var[index].bit_num



Moreeasily edit online programs.

Whenediting an online program you can:

e lIdentify inserted, deleted, or modified rungs

e View the original program while you are editing an online version

of the same program

e@ Monitor and modify timer and counter preset values

e Test online edits before permanently downloading them to the

Processor

e Set, force, and unforce variables from within the Editor

Whereto Find More Information

This instruction manual describes the AutoMax Enhanced Ladder

Editor. For information about the Ladder language, refer to

instruction manual J2-3094. The information in both instruction

manuals can also be accessed in the AutoMax Ladder Editor and

Enhanced Ladder Languagehelpfile (MAXED.HLP). The help file

contains additional information not found in either instruction

manual.

For more information about the AutoMax Programming Executive,

refer to J2-3089.
 

 

The thick black bar shownat the right-hand margin of this page

will be used throughoutthis instruction manualto signify new or

revised text orfigures.
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1.0 Getting Familiar with
the Editor
This section describes some basic information to help you become

familiar with the Editor.

1.1 Overview of the AutoMax Ladder

Editor Window

Instruction PaletteLadder Language Toolbar Menu Bar Program WindowsStandard Toolbar

Editor Window
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Minimized Program Status Bar

Rung Status Area

 
e Ladder Language Toolbar: Provides accessto the individual

ladderinstruction palette

e Standard Toolbar: Provides shortcuts to common commands by

clicking on a button

e Editor Window: Identifies the name of the currently active

program and provides accessto the application window controls

e Instruction Palette: Lets you drag and dropinstructions into

your program

e Menu Bar: Provides accessto the available Editor commands,

many of which can be accessed via a standard toolbar button or

keyboard characters
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e Program Windows:Presents the open program(s). The nameof

the programislisted in each window

e Rung Status Area: Displays rung numbers, revision marks, set

triggers, and indicates active versus non-active powerflow

e Minimized Program: Can help organize many open programs

e Status Bar: Displays information about the program objects you

have selected, the state of the program in the active window, and

helpful messages

Refer to Appendix A for more information about the toolbars,
instruction palettes, and the status bar.

Opening Programs

Opening a programis thefirst step in editing it. Before you can open

a program, you must have addedit to the rack using the Task
Managerapplication.

You can open a program from the Task Managerapplication or from

the AutoMax LadderEditor.

To open a program from within the Task Manager application

e From the Task Managerapplication, select a task and choose

Edit from the Task menu.

To open a program from within the Editor

Step 1.

Step 2.

Step 3.

Step 4.

Do oneofthe following:

@ Click on

or

e From the LadderEditor’s File menu, choose Open

The Opendialog boxis displayed.

Choosethe location of the file that you want to open. The

default drive and directory is the drive and directory from

which a program waslast opened.

 

To changethis: Dothis:
 

The drive and

directory in which to

search

Click in the Lookin list box. From

here choosethe drive and directory

that contains the program you want to

open.

 

 The directory in which

to search  Click on a folderor on file in thelist

of files and folders contained within a

directory.
 

From thelist of file names, select the program you want

to open. The default file type is ladder programs (*.pc).
You can openonly .pc programs using the LadderEditor.

Openthefile by clicking OK.

If the ladder program wascreated using an older version

laddereditor, the Editorfirst prompts you to convert the
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1.4

program. To convert the program, choose Yes. For more

information, see AppendixF.

You can have at most 15 unique offline programs opened at one
time.

Closing Programs

Close the active program with the Close command. The Editor stays

active and any other open programsstay open.

The Editor prompts you to save any changesto open programs

before closing.

To close a ladder program

Step 1. From the File menu or Program Control Menu, choose

Close.

Step 2. If you have made changesto the program since youlast

saved it, choose oneof the following buttons in the
message box that asks if you want to save the changes:

 

 

 

To: Click:

keep the changes Yes

not save the changes No 
keep the program open Cancel

and cancel the changes    
Saving Programs

Save changesto the active, offline program by using the Save
command. The Editor stays active with the same program openafter
saving the changes.

To save a ladder program

e@ Click on

or

e From the File menu, choose Save

The Editor saves global and local variables and their descriptions to

the program symboltable.

Tip

Any offline revision marks present in the program disappear once

you save a program.

Tip

To save changes madeto an online program, use the Accept or

Commit Test Mode Changes commands.For more information, see

Chapter5.0.
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Saving Programs Automatically As

You Work

To makesure that you do not lose work, you can use the Automatic

Save Every feature to save youroffline ladder programsat a

specified interval—for example, every ten minutes. Specify whether
you want your programsto be saved automatically and the time

interval to use within the General Options tab.

Files that are saved automatically are stored in the same directory

as the original ladder program and under the same name. However,

the file extension for an automatically savedfile is ASV.

To automatically save programs as you work

Step 1. From the Tools menu, choose Options.

Step 2. On the General tab, choose Automatic Save Every.

Step 3. Using the Minutes spinner box, chooseortypethe time

interval (in minutes) that you want the Editor to wait

before it automatically saves the ladder program. Choose

an interval from 1 to 120 minutes. The default setting is 10

minutes.

The program is saved at your specified time interval whenever a

changeto the program has been madesince the last automatic

save.

If a program youare trying to open has a morecurrent autosaved

copy, the Editor prompts you to chooseeither the autosavedfile or

the program file you last saved.

The auto-saved copy of a ladder program is deleted whenever you
save the program by using the Save commandorclose the

program.

Displaying a Program in Multiple Windows

To help you simultaneously view different parts of a program, you
can chooseto displayit in more than one window. Any changes you

maketo the program are reflected in the other window(s) in which

the program is displayed. When you open a new window, it
becomesthe active window and is displayed on top of all other

open windows.

To display a program in multiple windows

Step 1. Make surethat the program you wantto display in a new

windowis the active program.

Step 2. Doone of the following:

e From the Window menu, choose New Window.

or

e With no program items selected and the mouse

pointer positioned in the grid area,click the right

mouse button, and choose New Windowfrom the

pop-up menu.

The program window nameis appended by a “:#”. For example,if
you choseto display the program LINE_1.pc in a new window,the

new program window would be LINE_1.pc:2.
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Editing Different Parts of the Same
Program Using Split Windows

A program window maybesplit into two horizontal panes. Any
editing done in one paneis reflected in the other.

Each pane can bescrolled independently using its own vertical

scroll bar.

To view different parts of the same program using the Split

command

Step 1. From the Window menu,choose Split. The cursor turns
into a split pointer, a combination up arrow and down

arrow.

Step 2. Using the mouseor the up and downarrowkeys,
position the cursorat the point in the program where you

wouldlike to split the screen.

Step 3. Press ENTERorclick the mouse button onceto position

the split between the panes.

To view different parts of the same program byclicking on the

splitter bar

e@ While pointing to the splitter bar, press the left mouse button,

drag the splitter bar to the desired location, and release the

button.

To removethe splitter bar

e@ Click on the splitter bar and drag it to the top or bottom of the

window.

or

e Double-click anywhere on the splitter bar.

Editing Multiple Programs

You can edit multiple programs (up to 15) within the Editor at the

same time. Each program hasits own window. Only one window at

a time can be the active window, which you can identify by the
highlightedtitle bar and rung status area.

To edit multiple ladder programs from the Task Manager

Step 1. From the Task Manager, select each ladder program that

you wantto edit.

Step 2. From the Task Menu, chooseEdit. Thefiles you selected

are opened along with the Editor.

Step 3. From the Editor's Window menu, select Tile or Cascade.

All non-minimized programsare arranged within the

Ladder Editor window. Or, use the mouseto arrange the

windowson the desktop.

Step 4. Click on the program window to makeit active before

editing the program.
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To edit multiple ladder programsfrom the Editor

Step 1. From the File menu,openall the programs you want to

edit.

Step 2. From the Window menu,select Tile or Cascade. All

non-minimized programs are arranged within the Ladder

Editor window. Or, use the mouseto arrange the windows

on the desktop.

Step 3. Click on the program window to makeit active before

editing the program.

Tip

To switch among the programsyouare editing, press CTRL+F6.

Displaying/Hiding Revision Marks While

Editing Programs Offline

Revisions are always displayed while you are editing a program

online. But you can chooseto display offline editing revision marks.

Revisions are marked bya letter in the rung status area and by the

modified rung color.

 
Letter Meaning

M Logic was modified, or wires have been added

or deleted.

I The rung has beeninserted.

D The rung has been deleted.

 

 

     
Tip

If you delete a newly inserted rung before committing or saving the

change,the rung is deleted. However,it is not marked with a “D”

revision mark.

To display/hide revision marks while editing programsoffline

Step 1. From the Tools menu, choose Options. A tabbed dialog

box is displayed.

Step 2. From the General tab, locate the Miscellaneous group
box.

Step 3. Choose the Show Revisions While Offline Editing option.
This setting applies to the current and subsequent Editor
sessions until you change the setting again.

Step 4. Click OK to accept the newsetting.
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About Program Properties

The Program Properties dialog box contains three tabs:

 
Usethis tab: For:

Program Info viewing information about the program
 

 
Scan Info defining how the program should be

scanned and the program’s scantime.
    Error Log viewing the online error log 

To access Program Properties from the File menu

Step 1. Make sure no rungorinstruction is selected.

Step 2. From the File menu, choose Properties. The Program
Properties dialog boxis displayed.

To access Program Properties from the pop-up menu

Step 1. Make sure no rungorinstruction is selected, and position

the mousein the program’s grid area away from any
instruction or wire.

Step 2. Press the right mouse button. A pop-up menuis

displayed.

Step 3. From the pop-up menu, chooseProperties. The Program

Properties dialog boxis displayed.

See the AutoMax Enhanced Ladder Language Reference manual,

J2-3094, for how to interpret the entries in the error log. See section

1.11 below for defining program scantime.

About Program Execution

Programs can execute by being scanned or event-driven. An event

is a flag or indicator that one program can set or raise and another

program can wait for.

Scanned programs execute based on the scan timein ticks you

define. For a ladder program, you can define how often you want

the program to execute by defining scan timein ticks. The actual

scan time of a program is determined bythis formula:

scan time (ms) = tick rate of the Processor module * numberof

ticks.

You define the tick rate for the Processor module when you addit to
your rack configuration. By changing thetick rate, you can change

the time base for program execution. This allows you to run a

program based on a unit of your choice. You can setthe tick rate in
increments of 0.5 ms between 0.5 ms and 10.0 ms. The default

value is 5.5 ms. Thetick rate is defined separately for each

Processorin a rack. For more information, see section 1.11.1.

Event-driven programs can be controlled by either hardware events
or software events. When an event-drivenis first started (run), the

program executes once to completion. After this initial execution, the

program then waits for the designated event to occur. If you have
program logic that you do not wantto run during theinitial execution

of the program,use the pre-defined first_scan variable. An example

is shown here:
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1.11.2

First_scan pump_1 valyve_L

lft 1 | { ]

Hardware events are generated by an external condition. These

AutoMax modules can set a hardware event:

e UDC module (67652)

e Pulse Tach Input module (670421)

e Resolver Input module (57C41 1)

e 2-Channel Analog Input module (576409)

e@ 32-Bit Digital Input module (570419)

However, hardware events cannot be used on the AutoMax PC3000.

See a module’s instruction manualfor information aboutinterrupts.

For more information, see section 1.11.2.

Software events are flags generated by other programs. Software

events can be set by BASIC, control block, or ladder programs. For

information about programming software events, see your

programming language’s instruction manual and section 1.11.3.

Specifying a Scan Time To Control Program
Execution

For a ladder program, you can define how often you want the
program to execute by defining scan timein ticks. The actual scan

time of a program is determined by this formula:

scan time (ms) = tick rate of the Processor module * numberof ticks

Define the scan time by using the Scan Info tab under Program

Properties.

To define how often you want your program to execute

Step 1. Access Program Properties. Make sure no rung or

instruction is selected, and choose Properties from the

File menu.

Step 2. Choose the Scan Info tab.

Step 3. Select Scanned for the Scan Mode.

Step 4. In the Scan Time(ticks)field, enter the numberofticks

you wantto use. Enter a value from 1 to 32767. The

default value is 20.

For example, if you want a program to execute every 30

ms, and the Processor hasa tick rate of 3 ms, enter 10 in

the Scan Timefield.

Step 5. Click OK to accept the changes.

Specifying a Hardware Event To Control Program

Execution

Hardware events are generated by an external condition, such as a
digital input or a programmed hardware event from a Resolver

module. Specify the hardware eventthat triggers a program’s

execution by using the Scan Info tab under Program Properties.
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You can specify a timeout for the hardware event. This lets you
specify the maximum amountof timein ticks that can pass before

the hardware event occurs. You can use a timeout as a safeguard in

case something happensto the module you are using to generate
the hardware event. If the event does not occur before the timeout

time, a rack STOP ALLerror occurs.

To specify a hardware event

Step 1. Access Program Properties. Make sure no rung or

instruction is selected, and choose Properties from the

File menu.

Step 2. Choose the Scan Info tab.

Step 3. Select Event Driven for the Scan Mode.

Step 4. Select Hardware as the Event Type.

Step 5. In the Namefield, type the nameof the hardware event

that will trigger the program’s execution.

Step 6. In the ISCR Variable Namefield, type the name of the

variable associated with the ISCR(Interrupt status and

control) register on the hardware module being used to

generate the interrupt.

Step 7. Do oneof the following:

 

 

To: Dothis:

specify a timeout for the a. Select the Timeout

hardware event Enabled

b. Enter an integer value

between 1 and 32767

You should set the timeout to

a time longer than what you

expectthe actualtimewill be.

A good generalrule is 1.5

times longer than the

expected time between
events.
 

not use a timeout Makesure the Timeout

Enabled checkboxis not

selected.    
8. Click OK to accept the changes.

Specifying a Software Event To Control Program
Execution

A software eventis a flag set by another program. Specify the

software eventthat triggers a program’s execution by using the

Scan Info tab under Program Properties.

To specify a software event

Step 1. Access Program Properties. Make sure no rung or

instruction is selected, and choose Properties from the

File menu.

Step 2. Choose the Scan Info tab.

Step 3. Select Event Driven for the Scan Mode.
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Step 4. Select Software as the Event Type.

Step 5. In the Namefield, type the nameofthe software event

that will trigger the program’s execution.

Step 6. Click OK to accept the changes.

Running and Stopping Ladder Programs

Use the Online Task Managerto place a program into run or to stop
a program. If you are editing online, you must pause the Editor

before you can access the Online Task Manager, since they both

share the same communication channel. See “Pausing the Editor,”

section 5.3, for more information.

Exiting the Ladder Editor

Exit the Editor with the Exit command. The Exit commandclosesall

program windowsand closesthe Editor.

The Editor prompts you to save any changes to open programs

before exiting. If you choose to close an online program that has

changesthat have not been accepted, the Editor prompts you to

return to the editing session or close. Selecting close discardsall
the changes.

To exit the Editor

Step 1. From the File menu, chooseExit.

Step 2. If you have made changesto any open ladder program

since you last saved it, choose oneof the following

buttons in the message boxthat asks if you want to save
the changes:

 
To: Click:

keep the changes Yes
 

 
not save the changes’ No
    not close the program Cancel 

Tip

You can also exit the Editor by choosing Close from the Editor

Control menu.
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2.1

Editing Programs
This chapter describes how to use the Editor to edit programs
offline. See chapter5 for information about editing programs online.

Starting a Rung

Thefirst step in entering ladderlogic is inserting the first instruction

in the rung. Place the first instruction of a rung against the left power
rail.

All rungs are aligned against the left powerrail.

To start a rung

Step 1. Click on the Ladder Language toolbar button that

accessesthe group ofinstructions you need.

Aninstruction palette appears.

Step 2. Point to the instruction you wantto insert, and press and

hold the left mouse button.

Step 3. While holding down the mousebutton, drag the

instruction into the program area and next to theleft

powerrail. While you are dragging the instruction, the

cursor changesto indicate whether you can drop the

instruction and whereit will be placed. Instructions

destined for the left powerrail will looklike H F or l=

Step 4. Whentheinstruction is where you wantto placeit,

release the left mouse button, dropping the instruction

into place.

IMPORTANT

You mustplacethefirst instruction of a rung so thatit attaches to the

left powerrail to start a rung. If you place it anywhere else in the

program window, you mustthen cut, paste, or drag to connectit to
the powerrail. You cannot draw a wire to connectit to the left power

rail.

Tip

If you frequently use a particular instruction on a toolbar palette, you

may wantto turn the toolbar palette on. Once a toolbar palette is on,

just point to the instruction you wantto insert, and press and hold

the left mouse button to drag the instruction from the palette.
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Defining the Horizontal and Vertical Grid Limits Per
Rung

You can definelimits for the size of the grid used by the Editor to lay

out each rung. This lets you make sure that your program printouts
fit on your preferred pagesize without the rungs being split up.

Relay instructions occupy a grid space of 1 x 1. More complex

instructions occupyat least 3 units horizontally by 2 to 8 units

vertically.

The default grid size per rung is 40 horizontal units by 24 vertical

units, which is also the maximum grid size per rung.

The Editorlets you place instructions outside the grid limits. Rungs
that exceed eitherlimit cause a warning to be displayed during a

verify operation. The limits you set are checked only when you

perform a verify operation.

To define the horizontal and vertical grid limits per rung

Step 1. From the Tools menu, choose Options. A tabbed dialog

box is displayed.

Step 2. From the General tab, locate the Per Rung Instruction

Grid group box.

Step 3. Enter the desired values for the Horizontal and Vertical

fields. The Editor uses these newvaluesforall

subsequent programs you open.

Step 4. Click OK to accept the newgrid size.

Turning the Grid On and Off

Use the grid to help you see whereinstructions will be placed and

where you can draw wires. You can select whetherto display the

grid used by the Editor to lay out rungs. The grid is displayed using
+ symbols.

To turn the grid on or off from the View menu

e From the View menu, chooseGrid.

Selecting Rungs

Before you can copy, cut, or move a rung, you mustfirst selectit.
You can select a rung by doing anyof the following:

e@ Click on or near the rung number.

or

@ Click on the rung description text (when displayed).

or

e Draw a selection box around the entire rung. A selection box is a

dotted-line rectanglelike this:

A selected rung lookslike this: | ‘o) 



Tip

If rung numbers are not displayed, you canstill select the rung by

clicking in the rung status area next to the rung.

To select a rung by drawing a selection box

Step 1. Think of the rung you want as being enclosed in a box,

and position the pointer on the white spaceat either the

top or bottom “corners.”

Step 2. Press the left mouse button. The cursor changesto +.

Step 3. Draw aselection box around the rung by moving the

mouse diagonally across the rung. You cannot draw a

selection box to encompass more than one rung.

Tip

If the rung you are selecting extends beyond the screen

display, you can scroll the screen to display the

remaining rung logic by extending the selection box

against any side of the program window.

Step 4. Once the rungis enclosedin the box, release the mouse

button. The rung is now selected.

To select multiple, contiguous rungs by dragging the mouse

Press and hold the mousebuttonin the rung status area, and drag

the mousein either direction (up or down) to select additional rungs.

To select multiple, contiguous rungs by selecting the first and
last rung

Step 1. Select a rung.

Step 2. Scroll the screen as necessary to display the last rung

you wantto select.

Step 3. Hold down SHIFT and select the last rung by clicking in

the rung status area next to the rung.

To selectall the rungs in a program

e@ From the Edit menu, choose SelectAll

or

e Press CTRL+A

or

e From the program window pop-up menu, choose SelectAll.
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2.3 Entering Rung Descriptions

Rung descriptions help you document the program’s logic so that

others can understand the function of each rung and help make

troubleshooting easier. Rung descriptions can contain a maximum
of 16 lines, with each line containing a maximum of 80 characters of

text.

You must turn on rung descriptions to view them in the program.

To enter a rung description in the program window

Step 1. Make sure Rung Descriptions are turned on.

Step 2. Select the rung to which you want to add oredit a

description. The rung description field, which is a dotted

line box, is displayed above the rung. For more

information, see section 2.2.

Step 3. Click in the rung description field and enter the

description.

Tips

e Start a new line by pressing CTRL+ ENTER.

@ Move aroundin the rung description field by using the mouse,

HOME, END andthearrow keys. Delete text by using

BACKSPACEor DELETE.

e You can also cut, copy, and paste text in rung descriptions. See

the AutoMax LadderEditor and Enhanced LadderEditorhelp file

for more information.

To enter a rung description in the Rung Properties dialog box

Step 1. Select the rung to which you wantto add or edit a rung

description. For more information, see section 2.2.

Step 2. From the File menu, choose Properties.

Step 3. In the Rung Descriptionfield, type in the description.

Step 4. Click OK to add the description.

Tip

You can also access the Rung Properties dialog box from the

pop-up menu. Select the rung or point to it. Then, click the right
mouse button and chooseProperties from the pop-up menu.



2.4 Inserting Instructions into a Rung

Build a rung by using the mouseto drag and dropinstructions from

an instruction palette and connect them together by drawing wires.

The program areais like a blank canvas— youdrag instructions
from the instruction palettes and drop them in the program area. But

first, you must start a rung by dragging an instruction from an

instruction palette and droppingit very near the left powerrail. To

help makeinserting instructions easier, the insert cursor indicates
when andin which direction you can drop aninstruction. See

section 2.1 for more information on starting a rung.

Whendroppedinto the rung, the instructions indicate where you
can attach anotherinstruction or wire. Contact instructions have

connectionsoneitherside, but coil instructions can only connect to

anotherinstruction on theleft side.

Forinstruction blockslike ADD, you can connect otherinstructions
to the longerlines. These longerlines attach to Boolean input and

output parameters.

An inserted instruction belongs to the rung aboveit if the newly

inserted instruction does not start a rung.

To insert instructions into a rung

Step 1. Click on the Ladder Language toolbar button that

accessesthe instruction palette you want to use.

The instruction palette appears.

Step 2. Point to the instruction you wantto insert.

Step 3. Press and hold the left mouse button while dragging the

instruction into the program area.

Step 4. When the pointer is where you want the upper-left corner

of the instruction to be, release the left mouse button,

dropping the instruction into place.

If you drop an instruction very near another, the newly-placed

instruction automatically connects to the one adjacentto it. Similarly,
you caninsert an instruction between twoinstructions by simply

dragging it betweenthe existing two.

Tip

If you frequently use the instruction on a toolbar palette, you may

wantto turn the toolbar palette on. See “Turning the Toolbars and

Palettes On and Off” in Appendix A.

Tip

If you delete or cutthe first instruction of a rung, the left powerrail

connection stays, indicating that you can insert a newinstruction.
Insert the newinstruction to the right of the left powerrail connector.

Tip

You can moveor copy one or moreinstructions from one rung and

insert them into another rung. See “Moving Instructions” and
“Copying Instructions” in the AutoMAx Ladder Editor online help.
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Connecting Instructions (Drawing Wires)

Connectinstructions when you want to create branches(parallel

logic) or to connect two or moreinstructions together that were

placed too far apart for them to connect automatically. Connect
instructions by drawing wires.

You can usethe grid markers to help you determine where

instructions will be placed and where you can draw wires.

To connectinstructions

Step 1. Place the cursor near a connection point for an
instruction. For relay logic, the connection point is either

the left side (for coils) or both sides (for contacts). For
block instructions, the connection points are the free
endsof the longlines.

Whenthe cursoris near a connection point, it changes to

include a pencil: iy

Step 2. Press and hold the left mouse button. The cursor
changesto a pencil.

Step 3. Draw the wire by moving the mouse towards the
instruction to which you want to connect. You can draw a
continuouswire to connectinstructions in a branch and
the coils at the end of the rung. A dottedline indicates

wherethe wire will be placed.

Step 4. When you reachthe destination connection point, release
the mousebutton.

The wire is drawn to connect the instructions.

Connecting Multiple Instructions by Using

the ENO Output Bit

Quickly build a rung by connecting a relay instruction or a Boolean

input of an instruction to the ENO output parameterof an instruction
block. For example:

  

 
+ EN

In

MOVE MOVE ;
Qut=In Qut=In coil

ENO EN ENGPy
BT1_DEST 0 BT1_UPDATE

Out In Out

 

     

The Boolean input parameter’s or relay instruction’s state is linked to

that of the ENO output parameter.

The ENO output parameter for an instruction follows the state of

that instruction’s EN input parameter unless an error occurs.

When an error occurs within an instruction, the ENO output

parameter is set according to the pre-defined variable
ERROR_ENO.Because the default value of ERROR_ENOis
false, instructions connected to the ENO output are disabled

when an error occurs in the instruction block containing the ENO
output. Should you want to continue evaluating and executing the

logic connected to an ENO output, set the variable ERROR_ENO

true.



2.7 Selecting Instructions

Before you can copy,cut, clear, or move an instruction, you must

first selectit.

To select an instruction

e@ Click on anypart of the instruction such as the instruction itself, a

variable usedin the instruction, or the description.

or

e Draw a selection box around the instruction. A selection box is a

dotted-line rectangle like this:

A selected instruction lookslike this:|

To select an instruction by drawing a selection box

Step 1. Think of the instruction you wantto select as being

enclosed in a box and position the pointer on the white

space at either the top or bottom “corners.”

Step 2. Press the left mouse button. The cursor changesto +.

Step 3. Draw aselection box aroundtheinstruction by moving

the mouse diagonally acrossthe instruction. Once the

instruction is enclosed in the box, release the mouse

button. The instruction is now selected.
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To select multiple, contiguous instructions by drawing a
selection box

e Draw a selection box to encompassthe instructions you want to

select. You can only select instructions that belong to the same

rung.

or

Step 1. Select an instruction.

Step 2. While pressing SHIFT, place the mousepointer on the

selected instruction and pressthe left mouse button.

A selection box appears.

Step 3. While holding down the mousebutton, drag the selection

box to encompasstheinstructions that you want to

select.

Tip

If the instructions you are selecting extend beyond where they are

displayed on the screen, you can scroll the screen to display the

remaining instructions by extending the selection box against any

side of the program window.

About Instruction Properties

The Instruction Properties dialog box contains two tabs:

 
Usethis tab: For:

Instruction e changing the instruction’s type

Info

 

e viewing the variable namesused in the

instruction’s input and output parameters
 
Variables e viewing the variables used in the instruction

e entering a variable description

e changing variable’s data type, scope,

initialization, and display format

e specifying a maximum array index    
To accessInstruction Properties from the File menu

Step 1. Select an instruction.

Step 2. From the File menu, choose Properties. The Instruction

Properties dialog boxis displayed.
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To accessInstruction Properties from the pop-up menu

Step 1. Point to the instruction, and press the right mouse button.

Step 2. From the pop-up menu, choose Properties. The

Instruction Properties dialog boxis displayed.

To display the variable properties tab, choose Variables. To display

information about the instructions, choose Instruction Info. Quickly
toggle betweenthe two tabs by using CTRL+TAB.

Changing anInstruction Type

You can changeaninstruction to another compatible instruction

without having to re-enter the variable namesfor the parameters.
This feature helps reduce the time required to make logic changes.

Compatible instructions are those with the same basic function

and/or the same numberof inputs and outputs. For example, you
can change an NOI instruction to a NCI instruction because these
instructions are compatible relay input instructions. Conversely, you

cannot change an NOI instruction to a CO or an ADDinstruction

becausethese instructions are not compatible.

To change aninstruction type by using Find and Replace

Step 1. Click on

The Find dialog boxis displayed.

Step 2. In the Objects group box, chooseInstruction.

Step 3. In the Find Instruction list box, choose the instruction for

which you want to search. Thislist only displays those

instructions that are compatible with the selected

instruction.

Step 4. ChooseFind.

The Editor searches the program for the instruction you

specified.

Step 5. Choose the Replace button.

Step 6. In the Replace Instruction list box, choosethe instruction

that you want to use in place of the instruction you are

searchingfor. This list only displays those instructions

that are compatible with the selected instruction.

Step 7. Choose Replace to replace the current instruction with
the new one or ReplaceAll to replace all occurrences of

an instruction with another.

To change aninstruction type by usingits Instruction Properties

Step 1. Select the instruction you want to change.

Step 2. From the File menu, choose Properties.

Step 3. Choosethe Instruction Info tab.

Step 4. From the Typelist box, choosetheinstruction type that

you wantto usein place of the selected instruction. This

list only displays those instructions that are compatible

with the selected instruction.

Step 5. Click OK to accept the change.
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Tip

You can also accessthe Instruction Info tab from the pop-up menu.

Point to the instruction that you want to change, pressthe right

mouse button, and choose Properties from the pop-up menu.

Tip

You can also changethe information about the variables used in the

instruction. Simply choosethe Variables tab or press CTRL+TABto
display the Variable Properties.

Tip

To select the instruction and access the pop-up menu, place the

mouse pointer over the instruction and click the right mouse button.

Assigning Variables and Constants to
Ladder Instruction Parameters

Eachinstruction includes at least one input or output parameter. The

more complexinstructions contain parameters for multiple
non-Boolean inputs and outputs. Each parameter hasa variable

namefield in which you enter the variable name or constant that you

want to assign to the parameter.

To help makeassigning variables to instruction parameters easier

and faster, variables are automatically assigned a default data type

and scope whentheyarefirst entered. The default type is that most

likely to be used by the instruction. For example, the default type for
a variable nameentered for a relay instruction is Boolean. But for a

JMP, the default type is label. For most block instructions, the default

type for input and output parametersis integer.

Whenyou enter an element-indexed variable, a default maximum

array index is automatically assigned, which you can later change in

the Variable Properties.

The scope of the variable is determined by the caseofthefirst letter

of the variable nameyoutype.If the letter is upper case, the variable

defaults to being a globalvariable. If the letter is lower case, the

variable defaults to being a local variable.

To assign variables or constants to ladderinstruction

parameters

Step 1. Select the instruction for which you want to assign

variables. The variable namefield appears as a

dotted-line box.

Step 2. Click in this dotted-line box. The outline becomes solid

and a vertical text cursor appears.

Step 3. Type in the variable name or a constant you wantto use

following the naming conventions of the Editor. See the

reference information for the instruction you are

programming for more information about the allowable

variable types. The scope of a variable can beeither

global or local. When youfirst enter a variable, its scope

is defined based on the caseofthefirst letter you type.

An uppercaseletter defines the variable to be global. A

lowercaseletter defines it to be local. See section 2.15

for more information about a variable’s scope.
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Tip

If the variable has not been used before, a default data type and

scope is automatically assigned. If the variable is an array, the

maximum array index defaults to the value you entered as the
elementof the variable. For example, if you entered part[5] the value

of 5 would be entered into the Maximum Array Indexfield of the

Variable Properties.

If the element-index of an array is a variable, the Maximum Array

Index field contains a value of 1.

Tip

If the variable has been used before, you can save typing by using

Variable Smart-Matching. See section 2.12 for more information

about Variable Smart-Matching.

Tip

To enter hexadecimal constants:

e@ End hexadecimal constants with an “h” or “H”.

For example: 607H

e Ifthe hexadecimal constant begins with a letter, enter a leading 0

before the value.
For example: OA607H

e Ifthe most significant bit of the hexadecimal constant is set and

the constantis fewer than 8 digits, sign-extend it with “F’s” into

an 8-digit hexadecimal value.

For example: Enter 9C40H as OFFFF9C40H

The Editor converts a hexadecimal value to a decimal constant,

exceptfor the logical and Masked Moveinstructions.

Entering Variable Descriptions

Variable descriptions help you documentvariables used in

instructions. Each variable can have its own description; however,

the description applies to simple or array variables and not to

indexed variable names. For example, the description displayed for
the variable TANK.fill would be for the variable TANK.

The descriptions can contain a maximum of 40 characters.

You must turn on variable descriptions to view them.

To enter a variable description by clicking into the variable

description field above a variable

Step 1. Make surethat the variable descriptions are turned on.

Step 2. Select the instruction.

Step 3. Click in the variable description field above the variable

for which you want to enter a description. When selected,

the variable description field is outlined by a solid border.

Step 4. Enter a description containing a maximum of 40

characters.

Tip

A shortcut to entering a variable description is to click twice on the

variable name and press TAB to advanceto the variable description

field. Enter a maximum of 40 characters of text.
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To enter a variable description by using the Variables tab in the
Instruction Properties dialog box

Step 1. Select the instruction that contains the variables you want

to document.

Step 2. From the File menu, choose Properties. The Instruction

Property dialog boxis displayed.

Step 3. Choose the Variables tab. The Variables Properties boxis

displayed.

Step 4. In the Namelist box, choosethe variable you want to

document.

Step 5. Click on the Description field, and type in the description.

Step 6. Click OK to add the description.

Tip

You can also accessthe Variable Properties dialog box from the

pop-up menu.Point to the instruction containing the variables to

which you want to add or edit a description, press the right mouse
button, and choose Properties from the pop-up menu.

Tip

Move around in the namefield by using the mouse, HOME, END,

and arrow keys. Delete text by using BACKSPACEor DELETE.

Tip

To select the instruction and access the pop-up menu, place the
mousepointer over the instruction and click the right mouse button.

Using Variable Smart-Matching

Variable smart-matching is an option you can use to help you enter

variable namesin less time. The Editor maintains an alphabetical
and case-sensitivelist of variables you have used. When this option

is on and you begin entering letters in the variable namefield, the

first variable namein the Editor’s list that matchesthefirst letter or

letters you have typed appearsin the variable namefield. For
example,if you have previously used the variables “pump” and

“packet” and youtypetheletter “p” in a variable name, the word

“packet” is inserted into the variable namefield. If “packet” is the
variable name you want, you can stop typing. If you had typed a “P”

global variables (which begin with an uppercase P) would have

been offered by the Variable Smart-Matching option.

If variable smart-matching displays a variable namethat you only

want to use part of, you must delete the extra characters by pressing

BACKSPACEor DELETE.

To turn the Variable Smart-Matching option on and off

Step 1. From the Tools menu, choose Options. The Option dialog

box is displayed.

Step 2. Choose the General tab and locate the Miscellaneous

group box.

Step 3. Choose the Variable Smart-Matching option. This setting
applies to all subsequent editing sessions.

Step 4. Click OK to accept the newsetting.
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To scroll throughthe available variable namesthat match the

character(s) you have typed

e To advance, press CTRL and the downarrow.

e To move backward through the matching variable names, press

CTRLandthe up arrow.

The Variable Smart-Matching option provides matches to each part
of an element-indexed and/orbit-indexed variable. Enter the

element-index orbit-index delimiter and thefirst letter or letters of

the element or bit name. Then, scroll through the variable name
choices offered. The choices offered by the variable smartmatching

option are determined by how manyletters you typein.

Tip

e@ To append onto a variable namepicked from the variable

smart-match choices, make sure the variable nameis not

selected before continuing to type.

e To re-initialize smart-matching, delete characters (by using

BACKSPACE), and re-type one or more.

Tip

If you type a question mark(?) as thefirst letter of a variable name,

the Editor automatically smart-matches onthefirst variable in your
variable list.

Selecting Variable Names

Before you can copy,cut, or clear a variable name you mustfirst

selectit.

To select a variable

Step 1. Select the instruction that contains the variable you want
to edit. The variable namefields appear as dotted-line
boxes.

Step 2. Click the dotted-line box. The outline becomesa solid

box and the text is selected.

Changing a Variable’s Data Type

Whenyou enter a variable namein an instruction’s input or output
parameter, a default data type is assigned based on theinstruction

type. If you want to change a variable’s data type to something other

than the default, you can changeit by using the Variable Properties
tab.

IMPORTANT

Changing the properties of a variable affects the variable, not just a

particular instance in whichit is used. For example, if you change
the data type of a variable from timerto integer and that variable

happens to be used in a TON instruction, this integer variable will no

longer be allowed within the instruction.
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To changethe data type for a variable

Step 1. Select the instruction containing the variable whose data

type you want to change.

Step 2. From the File menuor the pop-up menu, choose

Properties. The Instruction Properties dialog boxis

displayed.

Step 3. Choose the Variables tab. The Variable Properties tabis
displayed.

Step 4. If the nameof the variable you wantis not displayed in

the Namefield, use thelist box to scroll through a list and

chooseit. The Variable Properties dialog box forthat

variable is displayed.

Step 5. Using the Typelist box, choosethe data type for the

variable.

Step 6. Click OK to accept the change.

Tip

Integer variables default to a 16-bit integer. If you want the variable

to be a double integer (32-bits), you must changeits type to double
integer.

Tip

Quickly toggle between the Instruction Info and Variables tabs by
using CTRL+TAB.

Tip

To select the instruction and access the pop-up menu, place the

mousepointer over the instruction and click the right mouse button.

Changing a Variable’s Scope

The scope of a variable can be either global or local. When youfirst

enter a variable, its scope is defined based onthe case ofthe first

letter you type. An uppercaseletter defines the variable to be
global. A lowercaseletter definesit to be local. You can change a

variable’s scope by using the Variable Properties tab.

Compoundvariables (element-indexed or bit-indexed variable
names) are treated as separate variables with their own properties,

including scope. For example: TANK.fill is a compound variable.

TANKis a global variable andfill is a local variable. For
element-indexed and bit-indexed variables using a numberas the

index, the scope of the variable is determined by the named

variable. For example, the scope of the variable TANK.31 would

would be determined by TANK, which would appearin the variable
list. If the variable were TANK.31, only TANK would appearin the

variable list and have a scope.

IMPORTANT

Changing the properties of a variable affects the variable and not

just a particular instance in whichit is used. If you change a

variable’s scope, the change applies to every instance where that
variable is used.



To changea variable’s scope

Step 1.

Step 2.

Step 3.

Step 4.

Step 5.

Step 6.

Tip

Select the instruction containing the variable whose

scope you want to change.

Accessits Instruction Properties by choosing Properties

from either the File menu or the pop-up menu. The

Instruction Properties dialog boxis displayed.

Choosethe Variables tab. The Variable Properties tab is

displayed.

If the name of the variable you wantis not displayed in

the Namefield, use the list box to scroll through and

chooseit. The Variable Properties tab for that variable is

displayed.

Click on either the Global or the Local option. The

variable name changesto beeitherall upper case or

lower case, depending on which option you chose.

Click OK to accept the change.

Quickly toggle betweenthe Instruction Info and Variables tabs by
using CTRL+TAB.

Tip

To select the instruction and access the pop-up menu, place the
mousepointer overthe instruction and click the right mouse button.
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3.0 Printing Programs
Print a program to mark up or maintain a paperrecord of it. You can

print:

e@ an entire program or a range of rungs

e@ rung descriptions

@ only rung descriptions

e variable descriptions

e instruction cross-reference

@ program cross-reference

e multiple copies of a program

The ladder diagram prints out on the default printer you have
defined for the computer. Makesure that this printer is connected

and the properprint driver is installed. See the Windows 95

documentation for more information.

You can print a program by choosing:

e the Print button from the Standard toolbar

e@ Print from the File menu

To print a program from the Standard toolbar

Step 1. Make sure that the program you wantto printis in the

active program window.

Step 2. Choose

To print a program using the Print command

Step 1. Make sure that the program you wantto printis in the

active program window.

Step 2. Do one of the following:

e From the File menu, choose Print.

or

e Press CTRL+P

The Print dialog box appears. You can usethe Print

dialog box to change the numberof pages, page

orientation, or set new print options.
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Step 3. Use this table to help you with your next steps:

 

 

 

 

To: Do the following:

print all the rungs in In the Print Range box, selectAll.

the program

print only the rungs In the Print Range box, select

within a selected Selected Rungs.

range

print more than one Enter or select the numberof

copy of the program copies using Copies.
 

define page margins Choose Page Setup.
 

define otherprint Choose Options.

options    
Step 4. When you are readyto print the program, choose OK.

The documentis sent to the printer that is displayed at
the top of the dialog box (the default printer).

WhatIs Included in a Printed Copy of a
Program

Your program printout includes the items you have chosento print

using the Print Options tab.

A program printout includes:

e headerinformation, which describes the program’s path, whenit

waslast edited, and whetherthe pageis the program’s source

code or cross-reference

e@ rungs, which you canselect to print using the Print Options tab

e variable and rung descriptions, both of which you can select to

print using the Print Options tab

@ program andinstruction cross-references, both of which you can

select to print using the Print Options tab; see below for more

information on the program cross-reference

e initial value table for the variables that have a user-specified or

retained initial value that is different from the default value

@ program properties table, whichlists pertinent data about the

program suchas:

e the program’s name and path

@ program’s scan time displayed in the Scan Info Tab of the

Program Properties

e the numberof rungs and symbols in the program

e the date the program was created and the date it was last

revised

e the size of the program’s image,its verify status, and the

amount of online reserve memoryit requires; see Appendix

D for more information



Whenyouprint the Program (task) cross-reference,it prints at the
end of the printout andis printed for the entire program, evenif you

selected only a range of rungsto print. The program cross-reference

contains the following items:

 

variable nametable This table includes each variable used in

the task, its data type, the instruction and

rung whereit is used, its I/O type, the

hardware address, its description, and the

line cross-reference. If the database does

not exist, the text “Unknown”is printed for

the descriptions and cross-reference

information.
 

rung table This table includes information about each

variable used as an output in the program,

including the rung numberwhere the

variable appears, its name,the instruction

symbol or mnemonic in which the variable

is used, I/O description, and the variable

description from the program variable

table.
 

messages

  
The Editor prints any messages about the

cross-reference summary,verify result

summaries, print processing, and

database processing after the rung table.

Whenprinting the program from the Editor,

verify warningsare printed if you have not

selected Ignore Warnings in the General

Tab.   
The items in the program are printed in the following order:

1. rungs

. instruction cross-reference(if selected)2

3. initial value table

4 . program cross-reference, including the variable table, runglist,

legends, scan information, verify error statement, and summary(if

selected)
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Setting Print Options

You can choosethe type of information to print on your programs’

printout. Chooseto print or not to print the following:

 

 

 

 

Descriptions Only

To print: Choose: Result:

a program’s ladder Rungs The rungsare printed.

logic rungs

any description Rung The rung descriptions print

assigned to rung Descriptions above the rung.

The line length is the same as

the page width. The description

is truncatedif it is longer than

the page width.

only rung descriptions Rung The rungs, variable descriptions,

and instruction cross-reference

are not printed.

You can also chooseto print the

program cross-references when

you choose Rung Descriptions

Only.
 

 

you track where

variable names are

written and where they

are read

Cross-Reference

any description Variable The variable descriptions are

assigned to avariable Descriptions taken from program symbol
table and are printed above
variable name,just as they are

displayed in the program.

information that helps Instruction The instruction cross-reference

is printed with each rung.

Whenonly a range of rungsis

selected, the instruction

cross-referencestill includes

referencesfor the entire

program.
 

variable nametable

and a rung table  ProgramCross-Reference  The program (task)

cross-referenceprints at the end

of the program printout after the

rungs. Included is a variable

nametable and a rung number

table.

Whenonly a range of rungsis

selected, the program

cross-referenceisstill printed

and provides referencesfor the

entire program.
 

Choose any print options on the Print Options Tab, which you can

accessfrom the Tools menu orfrom the Print dialog box. These
items are printed by default:

@ rungs

 
e variable and rung descriptions

@ program andinstruction cross-references



3.3

To define the print options

Step 1. Accessthe Print Option Tab by choosing:

e@ Options from the Tools menu and then the Print Tab

or

e the Options button on the Print dialog box

Step 2. Choose the items you wish to print when you print a

program. Your choicesarelisted within the Print What

group box.

Step 3. Click OK.

The options you choose apply to any program that you print.

Tip

° return to using the default print options, select the Use Defaults

utton.

Defining the Page Setup

You can change the page margins for the paper copies of the
programsthat youprint.

The default margins are:

e@ top and bottom margins, 1 inch

e left and right margins, 0.5 inches.

Once you set the page margins, they applyto all subsequent
programsthat youprint.

To set the page margins for the programsthat you print

Step 1. Do oneof the following:

e@ Click on

or

e From the File menu, choosePrint

or

e Press CTRL+P

Step 2. At the Print dialog box, choose Page Setup.

Step 3. Enter the new measurementsfor the top, bottom, left and

right margins.

Note: /f you choose margins that are less than the

printable area on the printer/paper, the printoutis still

printed, but the measured margin may not accurately

maich your selections.

Step 4. Click OK.
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3.4

Single Page

How a RungIs Printed To Fit ona

The Editor prints a rung (including rung descriptions, variable

names and descriptions, and instruction cross-references) on one

page.If a rung or aninstruction block cannot beprinted entirely on
one page and there are other rungs on the page, the Editor forces

the logic to a new page.If the rung or an instruction cannot be

printed entirely on the new page, the Editor breaks up the logic as

 

follows:

If a rung or The Editor: Thesplit is indicated as
instruction follows:

cannotbeprinted
to fit on the page:
 

vertically finishes printing it on a new

page
WwW This symbol

prints at the

bottom of the
page, indicating

lines continue on

the next page.

This symbol
prints at the top

of the page,

indicating lines

continue from the

previous page.
 

horizontally

  
wrapsit to the next line

Wrappedrungsare printed
across the page from top to
bottom thenleft to right.
This meansthatif one
branch of a rung cannot be
printed across the page,
the continuation of the
branch appears below the
last branch of the rung as

illustrated in the figure
below.

Whena wrappedrungis
printed on a page,the next
rung in the program prints
on anew page.  

This symbolprints on
the right side of the
page, indicating that
instructions are being
extended to the next
line.

This symbolprints on

theleft side of the page,
* indicating that the
« instructions are

continuations of the
rung or branch above.
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3.6

sae —J

Wires and instructions can also besplit. See the following example:

 

[> ==>

       
4)

I)

 

Mote that this instruction is a continuation from the

-- first branch.   

Inserting and Deleting Page Breaks

Use a page break to paginate a program’s printout for a cleaner
look.

To insert or delete a page break

Step 1. ‘If you are inserting a page break, select a program object

with which you wantto start a new page.If you are

deleting a page break, select a program objectthat starts

a new page.

Step 2. From the Insert menu, choose Page Break.

The Editor inserts or deletes the page break above the selected
program object. Page breaks are displayed horizontally across the

screen.

Printing a Range of Rungs

If you do not wantto print an entire program, you can print a range
of rungsthat you have selected.

To print a range of rungs

Step 1. Within the program, select the rungs you wantto print.

Step 2. Do one of the following:

e@ Click on

or

e From the File menu, choosePrint

or

e Press CTRL+P

Step 3. In the Print dialog box, choose Selected Rungs.

Step 4. Define page margins orprint options, if necessary.

Step 5. Click OK.

The documentis sent to the printer that is displayed at the top of the

dialog box (the default printer). If you have selected to print a

program cross-reference, oneis printed for the entire program.
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3.8
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Displaying and Printing Coils as
Right-Justified

Use the Right Justify Coils after Verify feature to automatically move
coils to the right side of the printout so that you can more easily

read your program. If coils are not blocked by anotherinstruction,

the Editor aligns them against thefirst vertical page break. Coils that
already extend past this page break are movedleft and up. (They

are not moved to the next page break.)

To display and print programswith right-justified coils

Step 1. From the Tools menu, choose Options.

Step 2. On the General Tab, choose Right Justify Coils after

Verify.

Step 3. Click OK.

Coils are only moved out to the grid limit whenthelimit is to the left
of thefirst vertical page break.

The default option is not to right-justify coils after verifying or printing

a program. The rungs are displayed and printed compressed up
and to the powerrail when you verify or print the program.

Printing Multiple Copies of Programs

You can print more than one copy of a program at time.

To print multiple copies of a program

Step 1. Make sure that the program you wantto printis in the

active program window.

Step 2. Doone of the following:

e@ Click on

or

e From the File menu, choosePrint

or

e Press CTRL+P

Step 3. Within the Print dialog box, use the Copies spinner box to

enter or select the number of copies you wantto print.



4.0 Verifying Programs
Use the Verify commandto help debug your ladder program. During

the verification process, the Editor checks your program and notifies
you of any errors that would prevent the program from running. If

you choose,the Editor can report less serious issues, called

warnings. See section 4.3 for more information. The error and

warning messagesalso include information about the rung and grid
location in which the error or warning occurred.

A program whoseverify operation results in errors is not

successfully verified and cannot be downloaded to a Processor and
run. If only warningsresult after a verify operation, the program is

considered verified. Look at the bottom right corner of a program’s

status bar or in the Program Info tab (Program Properties) for the
program’sverification status, either Verified or Not Verified.

As the Editorverifies a program, it automatically compresses the

rung to the left and up by deleting rows and columnsthat do not

contain an instruction and minimizing wire lengths. Coils are moved
outto the vertical page breakif the Right-Justify Coils after Verify

option is not selected. See section 3.7 for more information.

The Editor automatically verifies an online program when you
choose to commit any online changesor place the program in Test

Mode. Online program changes cannot be downloaded to a

Processorand run until they are successfully verified.

Each program hasits own Verify Output windowthatlists the error,

warning, and status messages generated during the verify process.

Becausethe Verify Output window is separate from the program

window, you can easily switch between the program and the verify
messages as you troubleshoot your program. Thetitle of the Verify

Output windowis the name of the program appended by a .LOG

extension. If you chooseto verify the program again while the Verify
Output window is open, the information in the window is overwritten.

Within the Verify Output window, you can searchfor text and print

the logfile.

Whenoffline programsare verified, the Editor does not check the

Variable Configurator or create a verify log file unless you set the

applicable options in the General tab of Tool Options. See sections

4.1 and 4.2 for more information.

To verify a program

Step 1. Make sure the program you wantto verify is the active

program.

Step 2. From the Tools menu, chooseVerify.
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4.1

4.2

Creating a Verify Error Log File

Select the Generate Log File option in the General Options tab to

create a log file on disk containing the sameerror, warning, and

status messagesasthe Verify Output window.Thisfile is stored in
the samepath as the program with the same namebut with a .LOG

extension. It can be opened and viewed using a text editorlike

WordPad®. The Editor generatesa log file for each program by

default.

To create a verify log file

Step 1. From the Tools menu, choose Options.

Step 2. On the General tab, select the Generate Log File option in

the Verify group box.

Step 3. To accept the change,click OK or Apply.

Tip

Deselecting this option prevents the Editor from generating the log

file.

Automatically Checking the Variable

Configurator Database While Verifying a
Program

Select the Check Variable Configurator Database option in the

General tab of Tools Options to automatically check the properties

of a variable against the Variable Configurator database. Whenthis
option is selected, the Editor determines whether:

e global variables used in the program are declared in the Variable

Configurator database

e global variables using Retained Valueinitialization are declared

as non-volatile

e global timer and counter variables are non-volatile

e array variables used in the program have the same dimension as

those defined in the Variable Configurator database

The Editor checks the Variable Configurator database by default.

To automatically check the Variable Configurator database while
verifying a program

Step 1. From the Tools menu, choose Options.

Step 2. On the General tab, select the Check Variable

Configurator Database option in the Verify group box.

Step 3. To accept the change,click OK or Apply.

Tip

Deselecting this option prevents the Editor from checking the

Variable Configurator database. This makesverifying a program

faster. However, you cannotinstall and run a program that contains
global variables that are not defined in the Variable Configurator

database.



4.3

4.4

Specifying Whether To Include Warning
Messages WhenVerifying Programs

Select the Ignore Warnings option in the General tab options from
the Tools menuto preventverify warnings from being displayed in

the Verify Output window and verify logfile (if the log file is

generated). Verify error messages are always displayed in the
output window andlogfile. By default, the Editor includes verify

warning messagesin the output window andlogfile of offline

programsthat you verify. The Editor does not include warning

messagesarising from committing online changesor placing the
program in Test Mode.

To prevent warning messagesfrom displaying in the verify log
file

Step 1. From the Tools menu, choose Options.

Step 2. On the General tab, deselect the Ignore Warnings option

in the Verify group box.

Step 3. To accept the change, click OK or Apply.

Resolving Verify Errors

The Verify Output windowlists error messagesand, if you choose,

warning messagesthat help you debug a program. Error messages

also include the rung numberand grid location of the logic in which
the verify error occurred. For example,

This error:

In Rung #8at location {4,1}

Variables of type Timer or Counter cannot be used on a coil.

Means:

The coil located in the fourth columnofthefirst row in rung 8 has

a timer or counter associated with it.

Becausethe Verify Output window is separate from the program

window, you can easily switch between the program and the verify
messages as you troubleshoot your program.

Tip

To switch betweenthe two windows, press CTRL+F6
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5.0 Editing Programs Online
Editing a program online lets you modify ladder logic andtheinitial

values of variables as well as set, force, and unforce variables. You
can be connected to a Processorvia a serial connection or a PC

Link interface connection. If you are connected via the PC Link

module, you can have multiple online programs from different

networked racks opened simultaneously.

While a program is running, you can view the powerflow of

executing logic, variable state information, and any instruction

runtime error codes generated.

An Overview of Editing and Downloading the Changes

Step 1. Open the program by using the Monitor PC Program

command from the Editor, Task Manager, or System

Configurator.

Step 2... Make your changesto the online program.

Step 3. Accept the changes.

Step 4. Download the program modifications to the Processor.

About the Changes You Can Make

While editing an online program, you can add newvariables with

somelimitations and restrictions, but you cannot add oredit variable
or rung descriptions. See “About the Limitations for Inserting and

Modifying Rungs in Online Programs” in Appendix D for more

information. When you add global variables, make sure the variables
are non-volatile and do not have retainedinitialization data. You

must define global variables in the Variable Configurator database.If

you enter a global variable in an online ladder program and that

variable is not in the Variable Configurator database, you get a verify
error when you commit the online changes.

IMPORTANT

Add global variables to the Variable Configurator database before

making the online changes.

You can also view rung and variable descriptions. When opening an

online program, you can choose whether or not you want to display

rung and variable descriptions. When you open an online program,
the logic is uploaded from the Processor to your computer. If you

chooseto display the variable and rung descriptions, these are

extracted from the program’s sourcefile, which must be accessible
by located on the computer you are using to edit the online version

of the program. For more information, see “Choosing To Display

Descriptions While Editing/Viewing an Online Ladder Program”in

the AutoMax LadderEditor and Enhanced Ladder Languageonline
help.
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About Accepting and Downloading Your Changes

Whenyouset, force, unforce, or changea variable’sinitial value, the

changetakeseffect immediately in the online program. Other

changessuch as adding, deleting, or modifying a rung must be
accepted before the change takes effect. You can accept oneorall

rungs that have been added, deleted, or changed. Accept changes

that you want to download to the Processor. Once any changesare
accepted, you can temporarily load them into the Processor(place

the program in test mode) or permanently download them to the

Processor (commit the changes).

Before any changes are downloadedto the Processor, either

permanently or temporarily, the changesare verified using the same

rules used for verifying offline programs. If the program does not
pass the verification process, you must correct the errors and

accept them again. An edited online program is downloaded to a

Processoronly whenall the accepted changesto the program have

been successfully verified. The verified changes are downloaded to
the Processoras a group, not as individual rungs. See “About How

Changes Made to Online Programsare Verified” in section 5.9 for

more information.

About Accessing the Online Task Manager

You can access the Online Task Managerfrom the Editor, Task

Manager, or the System Configurator. The Online Task Manager and

the Editor cannot share the same communication channel. If you
need to use the Online Task Manager while editing an online ladder

program, you mustplace the Editor in a paused state. By pausing

the Editor, you free up the communication channel so the Online
Task Managercan useit. See section 5.3 for more information.

Aboutthe States of Online Programs

An online program is in one of the following states at any time:

 
State: Description: Howthe stateis

indicated:
 
Run The programis actively

executing in a Processor

and powerflow is

displayed.

The word “RUN” appears

the Editor’s status bar, and

the left powerrail is

highlighted in the power

flow color. In the Online

Task Manager, the word

“Run” appearsin the status

column.
 
Stopped

  
The program is not actively

executing.

 
The word “STOP” appears

the Eqitor’s status bar. In

the Online Task Manager,

the word “Stopped”

appearsin the status

column.  



 

 

 

 

State: Description: Howthestate is

indicated:

Test The program is actively The text “Test Mode”

mode executing rungs, but the appearsafter thefile name

changes madeto an online in the window’stitle bar.

program are not See “Testing Programs

permanently installed in the (Test Mode),” section 5.8,

Processor. You can test the for more information.

changes you madeto an

online program.

Paused Whenthe Editor is paused, The status bar for windows

 

the programscontinue to

run in the Processor, but

their display in the program

windowis not updated.

The Processor connection

is freed so you can access

the Online Task Manager.

Because the Online Task

Managerand the Editor

cannot share the same

communication channel to

the Processor, the Pause

commandallows you to

place the Editor into a

pausedstate.

The online program

windowsthat are paused

after you select the Pause

commandfrom the Online

menuare:

e@ windows containing your

online programs

e Original Program

window

The Set/Force/Unforce
dialog boxis also closed.  

that are in the paused state

is blank and the text

“Paused” appears before
the file name in the

window’stitle bar. See

“Pausing the Editor,”

section 5.3, for more

information.
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5.2 Monitoring an Online Ladder Program

Before you can edit an online program, you must openit using the

Monitor PC Program commandfrom the Online menu. You access

this commandfrom the Editor, Task Manager, or System
Configurator.

To monitor an online ladder program

Step 1.

Step 2.

Step 3.

Step 4.

Step 5.

Step 6.

Close the Online Task Managerapplicationif it is running.

The Online Task Manager uses the sameonline

connection as an opened online program. Both

applications cannot be accessedat the sametime.

Do oneofthe following:

e From the Online menu of the Editor, Task Manager, or

Software Configurator, choose Monitor PC Program.

or

e@ Click on

The Monitor PC Program dialog boxis displayed.

Using the LookIn area of the dialog box, navigate to the

location containing the ladder program you want to open.

You can lookin these folders:

e Direct — for programsavailable in the Processorto

which you are connected

e Network — for programs located on Processors

connected to the network

Once you have located the program you want to monitor,

select the program’s icon displayed in the Files area of

the dialog box. To select more than one program to open,

do one of the following:

e Draw a selection box around the programs you want

to open.

e To select individual programs, press [CTRL] while

selecting the program icons with the mouse.

e To select all programs, select the first program, and

press [SHIFT] while selecting the last program.

Notice that the program’s name appearsin the File name

field.

If you want to view the rung and variable descriptions

while monitoring the online program, see “Choosing To

Display Descriptions While Editing/Viewing an Online

Program”in online help.

Click OK to open the program.

The program you selected is opened.

Tip

You can have multiple online programs openedat once.



5.3

5.4

Pausing the Editor

Because the Online Task Manager and online programsin the Editor

use the same communication channel, you must place the Editor in

the Paused state before you can use the Online Task Manager. The
programscontinueto run in the Processor, but their display in a

program window is not updated.

IMPORTANT

Before pausing the Editor’s online program windows, you might
want to commit any pending changes.All pending changesare lost

oncean online program is paused and then removedfrom the

pausedstate.

Any trigger information is also lost when you remove online program

windowsfrom the pausestate.

To pause or un-pausethe Editor

e From the Online menu, choose Pause.

or

e@ Click on [a

While online programs are paused, the status bar is blank and the

word “Paused” appearsin the programs’title bar.

Remove the programs from the paused state when the
communication port is again available. The Editor re-establishes

communication to all available ports and notifies you when a

connection is not available. If a connection is not available, the
online programsstay paused.

For more information about the paused state, see section 5.1.

About Power Flow

Powerflow indicates the rungs and instructions that are executing in

an online program. It is shown as a barof color that highlights wires
that are connected together. You can define the color of powerflow

using the Colors Option tab of program properties.

The state of a variable is shown asa solid block of color in the

contact. For positive transition contacts (PTI), the block of color is
shown whenthe contactis true, but powerflow from the contactis

shown only during the scan wherethetransition is true. The same

concept applies to the negative transition contacts (NTI). The block
of color in an NTI is shown whenthe contactis false, but the power

flow from the contact is shown only during the scan in which the

transition is true.

Hatch marksin the rung status area identify rungs that are not
executing. For non-executing rungs, the powerflow and last state

information you see are those from the last time the rung executed

since you started monitoring the online program. Factors causing
rungs not to execute are:

e They could be skipped via a Jumpinstruction.

e The program is executed based on an event.

e The program is stopped.

e The scan time of the programis very long.
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Monitoring Data in an Online Program

While a program is running online, the data is displayed as follows:

e Forced variables are highlighted in the Forced Variable color,

defined via the Color Option tab of the Program Properties.

e Numeric values are displayed underthe variable name. You can

define the data display format using the Variable Properties tab

for the variable but only in an offline program.

e Atimer’s elapsed value is displayed under the timer variable

name.

e Acounter’s current value is displayed under the counter variable

name.

e Ifthe preset of a timer or counter variable is changedvialogic,

the new presetvalue is displayed underthe original preset value.

e For variables using elementorbit-indexing, the display format is

that of the base variable. For example, if you specified variable

array to be displayed as decimal and the variable element to be

displayed in hexadecimal, the value of the variable array/element]

would be displayed in decimal.

e For element-indexed array variables (array[element]), the value

displayed is that of the element.

Accepting Changes Madeto Online

Programs

After editing an online program, you must approve the changes
before the Editor can download them to the Processor by using the

Online menu’s Accept command. You can accept modified, added,

or deleted rungseitherindividually or as a group. You can also
reject any change. Rejected changesare not recoverable.

You do not have to accept changesto an online program that are

made through the Set/Force/Unforce dialog box or that caused the
initial value of a variable to be changed because these changes take

effect immediately.



To acceptor reject changes madeto an online program

Step 1. When youarefinished editing an online program, do one

of the following:

e@ Choose Acceptfrom the Online menu

<a
Thefirst edited rung is highlighted and displayed along

with the Accept Online ChangesDialog box.

or  

  e@ Click on 

Step 2. From the Accept Online Changesdialog box, perform

one ofthe following actions:

 

 

 

Choose
To: this Result:

button:

Approve the displayed Accept The next edited rung is displayed

rung. for you to accept.

Approve all the rungs AcceptAll The Commit Online Changes dialog

that you added, box is displayed. You can

deleted, or modified. immediately download the changes

to the Processor or temporarily

download the changesto the

Processorby placing the program

in Test Mode. See “Downloading

Changes Madeto an Online

Program (Commit Online Chnges),”

 

      
section 5.7.

Discard the changes Reject The Editor returns the rungtoits

madeto the rung. original construction.

Cancel the Accept Cancel The Accept Online Changesdialog

processand return to box disappears. You can resume

editing the online editing the online program. Your

program. current modifications are

unaffected.

If you have accepted at least one rung, you can commit the change
or place the program in Test Mode. If not, you can resumeediting

the program.

5.7 Downloading Changes Madeto an Online
Program (Commit Online Changes)

After accepting added, deleted, or modified rungs, you must commit
the changesbefore the Editor can download them to the Processor.

You use the Commit Online Changesdialog box to do this. The

Editor automatically displays this dialog box after you havefinished
accepting the changes madeto an online program. You must have

accepted at least one online changefor the Editor to display the

dialog box.
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From the Commit Online Changes dialog box, you must choose
how to download the online changesto the Processor. You can

download the changesto the Processor by sending the changes to

the Processorand either:

e immediately install the changes in the program by selecting

Commit

e temporarily install the changes in the program by selecting Test

Mode

The changes are downloadedto the Processor as a group.

To download changes madeto an online program (commit)

Step 1. Accept the changes to an online program. See

“Accepting Changes Madeto Online Programs,” section

The Editor displays the Commit Online Changes cialog

box.

Step 2. From the Commit Online Changes dialog box, choose

one of the following:
 

 

Choose
To: this Result:

button:

Send the accepted online Commit The online changesare verified. See

changesto the Processor “About How Changes Made to Online

andinstall them. Programsare Verified,” section 5.9,

for more information.

Once the changesare successfully

verified, they are downloadedto the

 

Processor.

Send the accepted online Test Mode The online changesare verified. See

changesto the Processor “About How Changes Made to Online

and temporarily install Programsare Verified,” section 5.9,

them. for more information.

Once the changesare successfully

verified, they are temporarily

downloadedto the Processor. The

program is placed into Test Mode so

that you can see how your changes

perform before they are permanently
installed in the Processor. See
“Testing Programs (Test Mode),”

section 5.8, for more information.
  Cancel the Commit process Cancel The Commit Online Changes dialog

and return to editing the box disappears. You can resume

online program. editing the online program. Your

current modifications are unaffected.

Whenyouarefinished editing, you

must begin the Accept process again.    



5.8

5.8.1

Testing Programs (Test Mode)

Selecting Test Mode from the Commit Online Changes dialog box

places the program in the Test Modestate, which provides you with

an opportunity to make sure that the changes you made work
properly before you permanently install them in the Processor. Once

a program is in Test Mode, you can:

@ commit the online changes, which permanently installs the

program in the Processor(see section 5.8.1 for more information)

e@ take the program out of Test Mode, which allows you to resume

editing the program with your current modifications unaffected

(see section 5.8.2 for more information)

e@ cancelall changes

While a program is in Test Mode, you cannot make any changestoit

or download a configuration to a rack.

To place an online program in Test Mode

Step 1. After editing an online program, choose Accept from the

Online menu.

Step 2. Accept the online changes.

Step 3. From the Commit Online Changes dialog box, choose the

Test Mode button.

The online changesare verified. See “About How Changes Madeto

Online Programsare Verified,” section 5.9, for more information. If

the changesare successfully verified, they are installed in the
Processor. To make the changes permanent you must commit them.

Committing an Online Program in Test Mode
(Commit Changesin Test Mode)

Once a programis in Test Mode and youare satisfied with the

changes you made, you must commit these changesbefore they

can beinstalled permanently in the Processor. Use the Commit Test

Mode changes commandfrom Online menu.

To commit save an online program in Test Mode

Step 1. Make sure the programisin an active program window.

Step 2. From the Online menu, choose Commit Test Mode

Changes. The Editor prompts you to confirm your

decision.

Step 3. To commit the changes,click Yes. Clicking No removes

the question dialog box, leaving the program unchanged.

Once the rungs are successfully committed, the Editor removes the

program from Test Mode and displays the rungs in the non-modified

rung color.
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5.8.3
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Removing an Online Program from Test Mode

If you want to continue making changes to an online program thatis

in Test Mode, you mustfirst take it out of Test Mode. You can do this
by using the Quit Test Mode commandfrom the Online menu.

Taking a program out of Test Mode removes the changesfrom the

Processor. The modified rungs are no longer running on the
Processor; the original rungs are now executing.

IMPORTANT

If you delete a counter data structure as part of the online changes,
the counter hasretained its value while the changes werein Test

Mode. When you remove the program from Test Mode, the counter

is storing a current value since the change that deleted the counter
was not accepted.

If you delete a timer data structure as you edit an online program,

the timer is reset when you removethe program from Test Mode

without accepting the online changes.

To remove an online program from Test Mode while retaining

pending changes

Step 1. Make sure the programis in an active program window.

Step 2. Doone of the following:

e From the Online menu, choose Quit Test Mode

The Editor prompts you to confirm your decision.

or

 

e@ Click on

Step 3. To remove the program from Test Mode,click Yes.
Clicking No removes the question box, leaving your

program in Test Mode.

The online program continues to display the modified rungs. You
can continue to make changesor cancelall the online changes. You

must accept added, deleted, or modified rungs before they can be

installed in the Processor again.

Canceling All Changes Made to an Online Program

You can cancel any pending changes madeto an online program or
remove the program from Test Mode by using the CancelAll

Changes command. Pending changesare those that have not yet

been committed to the Processor. You cannot cancel changesto a
variable that resulted in setting, forcing, or unforcing it or changing

its initial value, since these changestake effect immediately.

To cancelall changes madeto an online program

Step 1. Make sure the programis in an active program window.

The program can bein Test Mode.

Step 2. From the Online menu, choose Cancel All Changes. The

Editor prompts you to confirm your decision.

Step 3. To cancel the changes,click Yes. Clicking No removes

the question dialog box and leaves the online program

unchanged.
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All pending changes are removed from the program. If the program
wasin Test Mode, it is removed from this mode.

About How Changes Madeto Online
ProgramsAre Verified

Once you commit any online changes after accepting the rungs, the
Editor verifies the changes before they are downloaded to the

Processor. The changesare verified using the samerules that are

used for offline programs. All accepted online changes must be

successfully verified before they are installed into a Processor.

Whenonline program changesare verified, the Editor ignores

warnings and does not check against the Variable Configurator
database.

The Editor generatesa log file only if you have selected the

Generate Log File verify option. For more information, see “Creating

a Verify Error Log File,” section 4.1.

If the program is not successfully verified, you must correct the

errors, re-accept the rungs, and commit the changesor enter test

mode. The Editor also notifies you wheneither of the following
events occur:

 

If this event occurs: Dothe following:
 

a global variable has been

defined in the program that

is notin the online

configuration

Step 1. Reject the changes contain-

ing the global variable(s).

Step 2. Commit any other changes.

Step 3. Gooffline and add the new

global variable(s) to the

Variable Configurator data-

base.

Step 4. Load the configuration.

Step 5. Monitor the ladder program

again and add the logic

with the global variables.

Step 6. Accept and commit the
changes.
 

the amount of memory for

the accepted online

changes exceeds the

amount of memory

reserved for online

modifications

Increase the amount of memory

allotted for online modifications. See

“Specifying the Amount of Memory

Reservedfor Editing a Program

Online” in Appendix D.

 
the online changes exceed

the allowed numberof

variables, timers, counters,

or labels  Edit the program to correct the

limitation errors and re-accept the

program. See “Specifying the Amount

of Memory Reservedfor Editing a
Program Online” in Appendix D.   

Tip

You can usethe Verify command to check your online changes

before you accept them.
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Viewing an Online Program as It Looked
Before It Was Edited

While you are editing an online program and before you commit any

online changes, you can view the same program asit appeared

before you began making modifications. The Editor displays the
original program in a separate window. Thetext “(Original Program)”

printed before thefile namein the window’stitle bar helps you

identify the original program from the edited version. Use the Show

Original Program commandto display an original version of the
program you are currently editing online.

To view an online program asit looked before it was edited
online

Step 1. Make surethe online-edited program for which you want

to view the original versionis in the active online program

window.

Step 2. Doone of the following:

e From the Online menu, choose Show Original

program.

or

e@ Click on

In the Original Program window, powerflow and rung numbersare
displayed as they appearin the online edited version. If a rung was

deleted, the corresponding rung in the Original Program window is

marked with a “D” revision mark and displayed using the color

defined for modified rungs.

The Editor updatesthe original program window with any changes

you maketo the online program. For example,if you insert a rung in
the online program, the rung numbersin the original program are

updated. However, you cannot make any changesto the original

program; it is a read-onlyfile.

Whenyou cancel all changes made to an online program, this
program then matchestheoriginal version. When you commit

changes madeto an online program, the Editor updates the version

displayed in the original program window to match the one in the
online program window.



5.11 Capturing the State of Logic in an Online

Program

While monitoring a program, you can freeze or capture the power

flow of a given rung using the Capture Trigger command from the

Online menu. Whenthetrigger is activated (becomestrue), the state
of the rung is captured and displayed. The rung’s powerflow

information is not updated on the computer; however, it continues to

run on the Processor. The Editor obtains trigger information from the

Processor. You can capture a rung’s status based on oneof the
following conditions:

e acoil turns on

e acoil turns off

@ an error occurs with an instruction in a rung

If more than one coil exists, the coil used for the trigger is a rung’s
upper-right-mostcoil. Once a triggeris set, it is active on the next

program scan. Triggers are edge-sensitive. (For example, a coil-on

triggeris activated the next time that the coil goestrue.)

Only onetrigger can be set for a rung, but you can set multiple

triggers in an online program. Theonlylimitation is the amount of

available Processor memory.

Triggers are local to the computerthat set the trigger. Other online

connections cannotview these triggers until they are activated.

A trigger remains set as long as the rungis displayed in the online
program window. Oncethe triggered rung scrolls off the screen, the

triggeris cleared. Also, closing an online program window clearsall

the triggers set in the program.

Rungsthat have triggers set are indicated by a letter displayed in

the rung status area representing the trigger type, either an “o”, “f”,

or “e”. Whena triggeris activated, this indicator is replaced by a “T.”

If a rung is marked by a revision mark,the trigger indicator replaces
the revision mark until the trigger is cleared.

This table summarizes somepoints to keep in mind if you set

triggers on rungs that already contain a trigger.

 
If a rung already hasa trigger set Then the Editor:

and you:
 

e@ modify the rung, or clears the trigger

e scroll the rung off the screen, or

e close the program window
 
select the sametrigger type for a new resets the trigger

trigger
 

   select a different trigger type for a clears the current

new trigger trigger and assigns

the newtrigger to the

rung
 

The Editor notifies you when another online connection has set a

triggerfor the same rung.
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5.11.2

Capturing the State of Logic Based on a Coil
Becoming True

You can freeze the powerflow of a rung based onits

upper-right-most coil turning on (becoming true). You use the Coil
On commandfrom the Capture Trigger menu. When a rung has a

Coil On trigger set, the rung is marked with a letter “o” in the rung

status area.

To set a Coil On trigger

Step 1. Select the rung orat least oneinstruction in the rung for

which you wantto set a trigger. See “Selecting Rungs,”

section 2.2, or “Selecting Instructions,” section 2.7, for

more information.

Step 2. From the Online menu,select Capture Trigger. Move the

mouseto the right to display the Capture Trigger menu.

Step 3. From the Capture Trigger menu, choose Coil On.

Whenthe coil goestrue, “T” is displayed in the status area and

powerflow stops updating. The state of the rung whenthe coil went
true is displayed until the trigger is reset or cleared.

Capturing the State of Logic Based on a Coil
Becoming False

You can freeze the powerflow of a rung based onits

upper-right-most coil turning off (becoming false). You use the Coil

Off command from the Capture Trigger menu. When a rung has a

Coil Off trigger set, the rung is marked with a letter “f” in the rung
status area.

To set a Coil Off trigger

Step 1. Select the rung orat least oneinstruction in the rung for

which you wantto set a trigger. See “Selecting Rungs,”

section 2.2, or “Selecting Instructions,” section 2.7, for

more information.

Step 2. From the Online menu,select Capture Trigger. Move the

mouseto the right to display the Capture Trigger menu.

Step 3. From the Capture Trigger menu, choose Coil Off.

Whenthe coil goesfalse, “T” is displayed in the status area and
powerflow stops updating. The state of the rung whenthe coil went

false is displayed until the trigger is reset or cleared.



5.11.3

5.11.4

5.11.5

Capturing the State of Logic Based on a Rung Error

You can freeze the powerflow of a rung based on a run-time error

occurring within the rung. Run-time errors may be those caused by
an instruction. You use the Rung Error command from the Capture

Trigger menu. When a rung has a Rung Errortrigger set, the rung is

marked with a letter “e” in the rung status area.

To set a Rung Errortrigger

Step 1. Select the rung orat least oneinstruction in the rung for

which you wantto set a trigger. See “Selecting Rungs,”

section 2.2, or “Selecting Instructions,” section 2.7, for

more information.

Step 2. From the Online menu, select Capture Trigger. Move the

mouseto the right to display the Capture Trigger menu.

Step 3. From the Capture Trigger menu, choose Rung Error.

Whena run-time error occurs for an instruction in a rung, “T” is

displayed in the status area and powerflow stops updating. The

state of the rung when the error occurs is displayed until the trigger

is reset or cleared.

Waiting for Triggers While Continuing To Edit

You can wait for triggers while continuing to work with the Editor.
After setting any triggers, you can minimize the program’s window

or open a new window for the program.

You can also display triggers in a program using two computers.

Use one computerto set and display the triggers for an online
program while using another computer to monitor the program,

including scrolling through the same online program.

Re-Activating a Trigger

You can reset an activated trigger on a selected rung. This

re-initializes a rung’s frozen trigger.

To re-activate a trigger

Step 1. Select the rung orat least oneinstruction in the rung

containing the trigger you wantto reset. See “Selecting

Rungs,” section 2.2, or “Selecting Instructions,” section

2.7, for more information.

Step 2. From the Online menu, select Capture Trigger. Move the

mouseto the right to display the Capture Trigger menu.

Step 3. From the Capture Trigger menu, choose Reset Trigger.
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5.11.6 Clearing a Trigger

You can removea settriggerfor a selected rung. Oncethetriggeris

removed, the rung’s status area returns to the state it was in prior to
the trigger being set.

To clear a trigger

Step 1. Select the rung orat least oneinstruction in the rung

containing the trigger you want to remove. See “Selecting
Rungs,” section 2.2, or “Selecting Instructions,” section

2.7, for more information.

Step 2. From the Online menu,select Capture Trigger. Move the

mouseto the right to display the Capture Trigger menu.

Step 3. From the Capture Trigger menu, choose ClearTrigger.

The Editor also clears triggers when the selected rung is scrolled

out of view on the screen or when an online program is closed.

5.12 Setting and Forcing Variables in Ladder
Programs

You can set and force variables in ladder programs to put them

temporarily in a knownstate for debugging purposes.To set, force,
and unforce variables, you must have an online program window

open. You can setor force any global variable in the configuration or

any local variable present in a task that is loaded into the rack.

IMPORTANT

You can force only simple variables. You cannot force

element-indexed orbit-indexed variables. For example, you cannot

force variableslike: vat.13, array_var[11], array_var[index_name],
array_var[11].12, or array_var[index_name].bit_name.
 

WARNING
 

THE SET AND FORCE FUNCTIONS BYPASS CONTROLOF THE APPLICATION
PROCESSBY THE APPLICATION PROGRAMS.IT IS THE RESPONSIBILITY OF
THE USER TO DETERMINE THE POTENTIAL HAZARDSINVOLVED. FAILURE TO
OBSERVE THESE PRECAUTIONS COULD RESULT IN BODILY INJURY.
 

 

WARNING
 

VARIABLES AND OUTPUTS THAT ARE FORCED BEFORE AC POWERIS LOST
WILL REMAIN FORCED WHEN AC POWERIS RESTORED. SHOULD AC POWER
BE LOST WHILE VARIABLES ARE FORCED, THE USER MUST ENSURE THAT
UNEXPECTED MACHINE MOVEMENT DOES NOT OCCUR WHENAC POWERIS
RESTORED. FAILURE TO OBSERVE THESE PRECAUTIONS COULD RESULT IN
BODILY INJURY.   
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AboutSetting a Variable

To set a variable is to write a valueto it that can be over-written by

an instruction in the same program, another program referencing

the same variable, or an external deviceif the variable is mapped to
an input. It is possible for a variable that is set to be over-written on

the next scan of the program. Forced values cannot be set.

The Editor stores and displays up to 64 set variables for the current
editing session. The Editor does not store thelist of set variables

after the current editing session has been completed. When you set

a variable, it is added to the bottom of the list. Once the 65th
variable is added to the setlist, the variable present at the top of the

set list is removed from thelist. Duplicate entries are removed from

thelist.

Whensetting variables that use variableinitialization, keep these
points in mind:

e@ Setting a variable using Retained Valueinitialization modifies the

variable’s retained value, and this value becomesits newinitial

value.

e@ Setting a variable using User Specified Valueinitialization

changesthe variable’s current value butnotits initial value.

About Forcing a Variable

To force a variable is to write a valueto it that cannot be over-written
by an instruction or another program referencing the samevariable.

Only unforcing the variable permitsits value to be changed. Up to

64 variables can be forced. Forced variables are stored on force
pages, a maximum offour, each containing 16 variables.

Aboutthe Set/Force/Unforce Dialog Box

Both setting and forcing operations for ladder programsare

selected from the Set/Force/Unforce dialog box. This dialog box can
be displayed in both a basic and an expanded form andis

associated with only one rack connection at a time. When you

choose the Set/Force/Unforce option from the Online menu,the
basic Set/Force/Unforce dialog box is displayed. This basic dialog
box takes up less room onthe screen than the expanded dialog box

so that you can view more of your program. The expanded dialog
box takes up more room, but has more options.

You can switch back and forth between the basic and expanded

dialog boxes using the More button in the basic dialog box and the
Less button in the expanded dialog box.

To set, force, or unforce variables, you must have an online program

window open. The same Set/Force/Unforce dialog box is used for
each online program window using the same rack connection.

Opening a program windowusing a different rack connection

disablesall fields on the Set/Force/Unforce dialog box, except the
force list, that applied to the previous rack connection. Only the

force list is actively updated on the Set/Force/Unforce dialog box for
the online program window(s) using the previous rack connection.

You can unfreeze this dialog by activating the online window thatis
used for the other rack connection. If you choose the

Set/Force/Unforce commandfrom the online program window with
the new rack connection, the Set/Force/Unforce dialog box is
updated to reflect the information for the new connection.
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Whenyouselect an offline program window orthe Verify output
window,the Set/Force/Unforce dialog box remainsin its current
state.

Setting Variables

To set a variable is to write a valuetoit that can be over-written by

anyof the following:

@ aninstruction in the same program

e@ another program referencing the same variable

e by an external deviceif the variable is mapped to an input

You can set any global variable in the configuration or any local

variable presentin a task that is loaded into the rack.

To set a variable

Step 1. Make sure an online program window is open.

Step 2. Doone of the following:

e@ Click on

or

e From the Online menu, choose Set/Force/Unforce.

The Set/Force/Unforce Variables dialog boxis displayed.
You should keep this dialog box open while you are
setting, forcing, or unforcing multiple variables.

Step 3. _If you wantto set a local variable, enter the name of the

program in which the variable is used in the Program
field. If the variable is a global one, leave thefield blank.

Step 4. Enter the nameofthe variable to be set. Only simple

variables and array elements can beset.

If you had a simple variable selected before you chose
the Set/Force/Unforce command, this variable is the

default. If no variable was selected, the last variable set,

forced, or unforced is the default.

Step 5. In the Value/State field, enter the value orstate to set.

For Boolean variables, the valid rangeis on, off, true,

false, T, F, 1, or 0. You can entereither decimal or
hexadecimal values for non-Booleanvariables.

Step 6. Click Set to set the variable.

Note: A value displayed in the Value/Siate field is the last value set;it
is not the current value. The valuein this field is not monitored.

Tip

To quickly fill in the Program and Variable Namefield for a local
variable you wantto force, select the variable in the program before

choosing the Set/Force/Unforce command. Selecting a global

variable in the program before choosing the Set/Force/Unforce
commandfills in the Variable Namefield in the Set/Force/Unforce
dialog box.



5.12.2

Tip

Selecting a variable from the Set Variables Listfills the parameters

within the Current Selection group box with the information for the

variable.

Forcing Variables

To force a variable is to write a valueto it that cannot be over-written
by another program referencing the same variable. You can force

any simple global variable in the configuration or any simple local

variable presentin a task that is loaded into the processor. Only
unforcing a variable permitsit to be changed by a program or an

external device.

IMPORTANT

You can force only simple variables. You cannot force

element-indexed orbit-indexed variables. For example, you cannot

force variableslike: vat.13, array_var[11], array_var[index_name],

array_var[11].12, or array_var[index_name].bit_name.

To force a variable

Step 1. Make sure an online program window is open.

Step 2. Do one of the following:

e@ Click on

or

e@ From the Online menu, choose Set/Force/Unforce.

The Set/Force/Unforce Variables dialog boxis displayed.
You should keep this dialog box open while you are
setting, forcing, or unforcing multiple variables.

Step 3. If you want to force a local variable, enter the nameof the

program in which the variable is used in the Program
field. If you want to force a globalvariable, leave thefield

blank.

Step 4. Enter the nameofthe variable to be forced.

Only simple variables can be forced. The simple variable

selected before choosing the Set/Force/Unforce
commandis the default. If no variable was selected, the

last variable forced is the default.

Step 5. —_In the Value/State field, enter the value orstate to force.

For Booleans, entertrue, false, T, F, on, off, 1, or 0. You

can enter either decimal or hexadecimal values for

non-Booleanvariables.

Step 6. Select the force page (1-4) on whichto store the variable

using the arrows in the Force Pagefield.

Specifying the force page lets you control how forced
variables are grouped. Variables grouped on one force

page can be unforced at the sametime.

Step 7. Click Forceto forcethe variable.

Forced variables change to the color you specified on the Colors

tab. The default color for forced variablesis red.
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Tip

To quickly fill in the Program and Variable Namefield for a local

variable you wantto force, select the variable in the program before

choosing the Set/Force/Unforce command. Selecting a global
variable in the program before choosing the Set/Force/Unforce
commandfills in the Variable Namefield in the Set/Force/Unforce
dialog box.

Tip

Selecting a variable from the Force VariablesList fills the parameters

within the Current Selection group box with the information for the

variable.

Tip

You can also view the force table in the Expanded

Set/Force/Unforce dialog box.

Unforcing Variables

Unforcing a variable allows it to be written to by any of the following:

e@ anotherinstruction in the program

e@ another program

e@ an external deviceif the variable is mapped to an input

You can unforce any global simple variable or any local simple

variable presentin a task that is forced.

To unforce a variable from the Variables dialog box

e Inthe Set/Force/Unforce Variables dialog box, enter the variable
and click Unforce. The selected variable must already be forced

before you can unforceit.

To unforce a variable

Step 1. Make sure an online program window is open.

Step 2. Doone of the following:

e@ Click on

or

e From the Online menu, choose Set/Force/Unforce.

The Set/Force/Unforce Variables dialog boxis displayed.
You should keep this dialog box open while you are

setting, forcing, or unforcing multiple variables.

Step 3. If you want to unforce a local variable, enter the nameof
the program in which the variable is used in the Program

field. If you want to unforce a global variable, leave the

field blank.

Step 4. Enter the nameofthe variable to be unforced. Only

simple variables can be forced. The simple variable

selected before choosing the Set/Force/Unforce
commandis the default. If no variable was selected, the

last variable set, forced, or unforced is the default.

Step 5. Click Unforce to unforce the variable.



5.12.4

5.12.5

5.12.6

5.12.7

Variables grouped on one force page can be unforced at the same
time. See “Unforcing an Entire Force Page,” section 5.12.7.

Tip

Selecting a variable from the Force VariablesList fills the parameters
within the Current Selection group box with the information for the

variable.

About the Expanded Set/Force/Unforce Dialog Box

Additional options not available in the basic Set/Force/Unforce
Variables dialog box can be displayed by clicking Morein the dialog

box. Use the resulting expanded dialogfor:

e Viewing the Total Numberof Forced Variables

e Viewing a List of Set or Forced Variables

e Unforcing an Entire Force Page

You can toggle back and forth between the basic and expanded

dialog boxes using the More and Lessbuttons.

Viewing the Total Numberof Forced Variables

The Forced Variables groupin the expanded Set/Force/Unforce
variables dialog box allows you to view the total numberof forced

variables (Total Forced), which can be a maximum of 64. Thetotal

forced is useful if you want to force a large numberof variables and

need to keep track of how many more you can force or need to
determineif forced variables are present on other force pages.

Viewing a List of Set or Forced Variables

You can view list of set or forced variablesin the list box of the
expanded Set/Force/Unforce dialog box.

To view a list of set or forced variables

Step 1. Make sure an online program window is open.

Step 2. From the Online menu, choose Set/Force/Unforce. The
Set/Force/Unforce dialog boxis displayed.

Step 3. Click More.

Step 4. In the expanded Set/Force/Unforce dialog box,click Set
Variables or Forced Variables. Thelist of variables for this

edit session is displayed in the List box. Up to 64 set

variables are displayed on a set variableslist. Up to 64

variables are stored on a forced variableslist (16 per
force page). You can view only one pageat a time.

Unforcing an Entire Force Page

You can unforce an entire page of forced variables. This option is

useful when you have grouped related forced variables together on

one page.

To unforce an entire force page

Step 1. Make sure an online program window is open.
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Step 2. From the Online menu, choose Set/Force/Unforce. The
Set/Force/Unforce dialog boxis displayed.

Step 3. Click More.

Step 4. In the expanded Set/Force/Unforce dialog box, use the
Current Pagefield to choosethe force page you want to

unforce.

Step 5. Click Unforce Page. The entire page is unforced.

Testing If Variables in the Rack Are Forced

Programsthat are running cantestif any variables in a rack are

forced. The logic can access the reserved global variable
FORCINGSTATUS@.This variable will be true if any variables in the

rack are forced.

Viewing and Clearing Run-Time Errors

You can view any run-time errors that occur in an online program
that you are monitoring. Use the Error Log to view error messages

from the task information log. You can accessthis log from the

Program Properties. The error log recordsthefirst, second, and last

(most recent) error that occurred in the program. Thelast error
numberandits text messageis displayed along with the rung

numberin which the error occurred. Information about any bus

errors (Error 31) is also displayed.

For specific information about run-time error codes, see the

AutoMax Enhanced Ladder Language Reference Manual, J2-3094.

To view run-time errors

Step 1. Make sure the online program for which you want to view

run-time errors is the active program.

Step 2. Access Program Properties dialog box in oneoffollowing

ways:

e With no program items selected, choose Properties

from the File menu.

or

e With no program items selected and the mouse

pointer resting on the grid area away from any

instructions or wires, press the right mouse button to

display the pop-up menu. From the pop-up menu,

choose Properties.

Step 3. Choose the Error Log tab.

To clear the error log

Step 1. Access the Error Log tab from the Program Properties

dialog box. See step 2 above for more information.

Step 2. Click Clear Errors.

Step 3. Click OK.



Appendix A

Toolbars, Palettes, and the Status Bar

A.1 About the Standard Toolbar

The Standard toolbar contains shortcut buttons to many menu commands, such

as cut, copy, paste, save, andprint. It is located by default at the top edge of the

program window,but you can moveit to another location. By pausing the
pointer over a toolbar button, you can display a brief description of the button.

You can chooseto display or hide the toolbar by choosing Toolbars/Palettes

from the View menu andselecting or deselecting Standard.

 

As a shortcutfor: Click this button:
 

 Opening a program

 
 

 Saving a program

 
 

 Printing a program

 
  
Cutting an object

a<
|W

AO]
||

  
 

 
Copying an object

 

Pasting an object

  
Finding a variable or instruction

 
 

Verifying a program

 

 

 Listing program variables and properties (Variable List) v  
 

 Changing the display size of a program (Zoom)

   
 

  
Accepting changesto an online program

Connecting online to a Processor      
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As a shortcutfor: Click this button:
 

Quitting test mode

i
 

Setting/Forcing/Unforcing a variable

fs
 

Showing the original copy of an online program  

&  
 

Pausing an online program  o
  Accessing context-sensitive help

 

h?    
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A.2 About the Ladder LanguageToolbar

The Ladder Languagetoolbar provides accessto the instruction palettes. Each

button on the toolbar provides accessto a certain group of instructions, such as
relay or arrays. It is located by default under the Standard toolbar, but you can

moveit to anotherlocation.

You can chooseto display or hide the toolbar by choosing Toolbars/Palettes

from the View menu and selecting or deselecting Ladder Language.

By pausing the pointer over a button, you can display a brief description that

identifies the instruction palette associated with the button.

 

To accessthese instructions: Click on this button:
 

relay
 

rT
 

 

timers and counters
 

)
 

 

shift and move instructions
 

aa
1011

 

 

    
  

   
 

comparison *

math
+

array
(3)
 

 

 

program control, immediate input and
output, and I/O read and write   

   
 

 

 



A.3 About the Instruction Palettes

You accessaninstruction palette by pointing and clicking on a Ladder

Languagetoolbar button. Oncetheinstruction palette is displayed, you drag

instructions from it and insert them into a program. Instructions that perform

similar operations are grouped together on a palette. For example,all relay
instructions are grouped togetheronthe relay palette.

If you frequently use instructions from a particular palette, you can choose to
keep it open. You can then just chooseaninstruction and dragit into your

program without having to click on the ladder toolbar palette. You can move

openedpalettes into the program area where it becomesa floating palette or

anchor them along any screen area’s edge.

The available palettes are:

Relays

e@ Normally Open Contact (NOI) e Always False Contact (AFI)

e Normally Closed Contact (NCI) e Coil (CO)

e Positive Transition Contact (PTI) e@ Set (Latch) Coil (SCO)

e Negative Transition Contact (NTI) e Reset (Unlatch) Coil (RCO)

e Always True Contact (ATI)

Timers/Counters

e Timer On Delay (TON) e Retentive Timer On (RTO)

@ Timer Off Delay (TOF) e Count Up Down (CTUD)

e Timer Pulse (TP)

Shift/Move

e@ Shift Left (SL) e Circular Rotate Bits Right (ROR)

e@ Shift Right (SR) e@ Move Bits Between Integers and

e Circular Rotate Bits Left (ROL) Double Integers (MVB)

e Circular Rotate Bits Left on e@ Move Source Data to Destination

Transition (RL) (MOVE)

e Circular Rotate Bits Right on e@ Masked Move (MVM)

Transition (RR)

Comparison

e@ Equal To (EQ) e Less Than (LT)

e Greater Than Or Equal To (GE) e@ Limit (LIMIT)

e Greater Than (GT) e@ Mask Compare (MSK)

e Less Than Or Equal To (LE) e@ Not Equal To (NE)
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Math

e Absolute Value (ABS) e Subtract (SUB)

e Add (ADD) e@ Logical AND (AND)

e Divide (DIV) e@ Logical NOT (NOT)

e@ Modulo (MOD) e@ Logical OR (OR)

e@ Multiply (MUL) e@ Logical Exclusive XOR (XOR)

e@ Multiply Divide (MDV) e Convert Integer Data to BCD

e@ Negate (NEG) (TO_BCD)

e@ Square Root (SQRT) e Convert From BCDto Integer Data

(BCD_TO)

Arrays

e Unary Array Operations (AR1) e Array Shift Down (ASD)

e@ Multi-Array Operations (AR2) e Array Shift Up (ASU)

e Array Compare (ARC)

Miscellaneous

e@ Set Event (SET) e 1/0 Write (IOW)

e Jump (JMP) e Immediate Input (IN)

e Label (LBL) e Immediate Output (OUT)

e 1/0 Read (IOR)

A.4 Moving Toolbars and Palettes

You can movethe standard and ladder language toolbars and the instruction

and paste palettes from their default position to any location to suit your working
style.

You can movea toolbar or palette to any edge of the screen where it becomes

anchored at the new location. You can also move a toolbar or palette into the

program window whereit becomesa floating toolbar, which you can move and
closelike a window.

To movea toolbaror palette

Step 1. Place the pointer on any space betweenthe buttons of the toolbar or

around the toolbaror palette.

Step 2. Press downtheleft mouse button and drag the toolbar or palette away

from its current location. The toolbar or palette becomesan outlined

box.



Step 3. Movethe toolbaror palette to any screen edge orto a location within the
program window and release the mousebutton.

 
When you: Thetoolbar or palette

becomesa: 
anchora toolbarorinstruction palette vertical toolbar or palette
at the left or right edge of the screen
 
anchora toolbarorinstruction palette a horizontal toolbar or palette

at the top or bottom of the screen 
movethe toolbar or palette toa a floating toolbar or palette

location inside the program window    
To anchora floating toolbar or palette

Step 1. Place your pointer on the edge ofthe toolbar or palette and press the

left mouse button.

Step 2. Drag the toolbar or palette to any edge of the screen and release the

mousebutton.

Tip

Closea floating toolbar or palette by clicking on x| , located in the upper

right-hand cornerof the toolbaror palette.

Tip

If you move a toolbaror palette out of the program windoworjust want to
restore the toolbars and palettes to the Editor’s default, click on the Restore

Defaults button in the Toolbar and Palette dialog box.

A.5 About the Status Bar

The status baris located at the bottom of the Editor window and displays
information about the program objects you have selected and the state of the

program in the active window. Lookat the status bar for helpful messages as

you work with your programs.

 

For Help, press FI
 

Verified

For the active program window,the status bar displays VERIFIED whenthe

program has been successfully verified and is ready for loading in to the
Processor.

NotVerified

If the program has not been successfully verified or changes have been made to
it since the last verify operation, the status bar displays NOT VERIFIED.

Run or Stop

For the active, online programs,the status bar showsif the program is running
(RUN) or stopped (STOP).

Help for the Selected Menu

The status bar shows abbreviated help for the selected menu item in the active

window.
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Nameand Description of Selected Object

For the active window, the status bar can display any of the following:

 

If this is selected: Status bar displays the:
 

single contactorcoil associated parameter and the primary variable description
 

single block parameter and description for the primary output
 

single rung  first line of the associated rung description
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Appendix B

Keyboard Shortcuts
Hereis a listing of keyboard shortcuts for the Editor.

 
To: Dothe following:
 
Open a program Press CTRL+0 
Save a program Press CTRL+S 
Print a program Press CTRL+P 
Accessproperties for a program item Press F2

Rungs, instructions, and variables

must beselectedfirst 
Moveto the nextfield Press TAB 
Moveto the previousfield Press SHIFT+TAB 
Select all the rungs in a program Press CTRL+A 
Cut rungs,instructions, ortext Select the item(s) to be cut and press

CTRL+X 
Copy rungs, instructions, or text Select the item(s) to be copied and

press CTRL+C 
Paste text Press CTRL+V 
Paste rungsorinstructions Press CTRL+V Drag the logic from

the Paste Palette 
Clear rungs, instructions, or text Select the item(s) to be cleared and

press DEL 

 

 

Go to arung Press CTRL + G

Turn on Rung Descriptions Only Press F5

Access the Zoom dialog box Press F7
 
Accessthe Find dialog box Press CTRL+F 
Accessthe Replace dialog box Press CTRL+R
 
Find the next match Press SHIFT+F4
 
Find the previous match Press SHIFT+F5
 

 

 

 

Accessthe Online Task Manager Press FQ

Monitor a PC program Press F10

Quit Test Mode Press CTRL+Q

Access the application window Press ALT+ Spacebar

control menu
 
Access the program control menu Press ALT+ — (dash)
 
Close the active window Press CTRL+F4
 
Switch to the next program window Press CTRL+F6
  Close the Editor  Press ALT+F4   
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Appendix C

Using the Pre-Defined (Reserved) Ladder

Language Variables

The Editor contains pre-defined variables that you can usein an individual
ladder program to:

e execute logic based on a Processor scan

e specify how to handle error conditions

e@ checkscan time execution

The pre-defined ladder language variables are local variables, which you can

usefor ladderinstruction parameters. Their names are reserved and appearin

the choices offered by the Variable Smart Matching option.

Using the Pre-Defined Program Scan Variables

Use the following Boolean variables to execute logic based on the Processor’s

scan. Only use these variables for input parameters (read-only):

 

e first_scan Usethis variable to execute logic during a program’s
first scan. This variable is true during the initial scan

of the ladder rung and false during all other scans.
 

e@ second_scan Usethis variable to execute logic during a program’s
second scan. This variable is true during the second

scan of the ladder rung and false during all others.
 
e last_scan Usethis variable to execute logic during a program’s

last scan. This variable is true on the final pass of the

ladder rung after you have selected TASK STOP. This

variable is not set when a STOPALLerror occurs.

To use the last_scan variable, your program scan
must be less than 0.5 seconds.

IMPORTANT

Do not use the last_scan variable in an event-driven
program. Because these programsare based on the

occurrenceof an event, the last_scan variable may
never be executed when used in an event-driven
program.    
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Using the Pre-Defined Error Handling Variables

Use the following Boolean variables to help you handle error conditions. Use

error_eno and no_error_log for output (read and write) parameters. You can use

task_error as either an input (read-only) or output (read and write) parameter:

 

e@ task_error This variable is set true wheneveran error is found.
Monitor the bit to see if an error occurs during execu-

tion and clear it by using the ladderlogic. This bit is

set true evenif errors are not being logged.
 

@ error_eno Use this bit to determine the value ENO outputswill

haveif the instruction has an error. The default value

is false, which disables any instructions that are con-

nected to the ENO output, possibly making math

expressions incomplete. When youset error_eno

true, you can continue the execution of the logic con-

nected to the ENO output evenif the instruction

block had anerror.

This variable can be changed during ladderlogic

program execution.
 

e@ no-_error_log Set this variable true to prevent errors from being

entered into the program error log or being seen by

the rung monitor. Only one error is logged for each

instruction per program scan; however, you may

want to prevent the errors encountered on certain

instructions from being entered into the errorlog.

The default state for the no_error_log is false. You
can suppresserror messagesfor a group of rungs
by changing this variable during program execution.

STOPALLerrors and parameterlimit errors for AR1,

AR2, and ARCinstructions arestill inserted into the

error log when the no_error_log variableis true.    
Using the Pre-Defined Ladder Execution Time Variables

Use the following double integer variables to help you check and monitor the
program’s execution time. Only use these variables as input parameters.

 
@ task_usec_max Usethis variable to monitor the maximum execution

time (in us) for the current program.

@ task_usec_now Usethis variable to monitorthe latest execution time
(in us) of the current program. The execution timeis
the real “clock”time it took the program to run from

start to finish. It includes the execution time for higher

priority programsandinterrupt service routinesif

they run while your program is running.

 

    
To reset these times, write a value of 0 into the variable.
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Appendix D

Online Editing Memory Limits

Limits exist for the amount of memory reserved for editing programs online. The

Editor reserves a default 4096 bytes for editing programs online. However, you

can change the amount of memoryreserved for online editing. See “Specifying

the Amount of Memory Reserved for Editing a Program Online”in this Appendix

for more information.

Each rung that was modified or added during an online editing session is

checked against the allocated amountof reserved memory when you commit

the changesor enter test mode(that is, when you download the rungsto the
Processor). If the total numberof online changes exceedsthe allocated memory,

a message box appearsto notify you. To continue editing a program online once

these limits have been exceeded, save the program to the PC and re-download
it to the Processor.

Limitations for Editing Programs Online

You cannot add morethan:

e@ 32 variables

e 8 timers and/or counters

e@ 16 labels

Theselimits are checked after you choose Accept from the Online menu. If the
changes exceed anylimit, the Editor notifies you of the location at which the

problem(s) occurred. The changesare not downloaded to the Processor. You

can then edit the program to correctthe limitation errors and re-accept the
program.

Restrictions for Editing Programs Online

While editing a program online you cannot add these typesof variables:

e a global variable that is not already used in the configuration

e new orexisting array variables

e@ an elementof an array that is larger than the defined Maximum Array

Index

e@ new Software Events

Otherrestrictions for editing programs online:

e You can changeall the properties for a newly added variable, but you

cannot add or changea variable description.

e You cannotinline edit variable or rung descriptions.

e You cannot change any Program Properties.

Someinstructions useinternal buffers to perform their operation. Consequently,

the state of the following instructions’ operation is stored from program scan to
program scan:

e@ Counterinstruction (CTUD)

e Array instructions (AR1, AR2, ARC, ASU, ASD)

e Shift Register instructions (SL, SR, RL, and RR)

e@ Set Event instruction (SET)

During online editing, the state informationis only transferred if you have not

added, moved, modified, or deleted any of the instructions. The Editor warns
you whenstate information is not transferred.
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Specifying the Amount of Memory Reservedfor
Editing a Program Online
You can increase or decrease the amount of memory reserved for changes

madeto an online program by using the Program Info tab of the Program
Properties. You must change the program’s properties in an offline editing

session of the program. The maximum amount of memory you can reserveis

20480 bytes; the minimum is 2048 bytes.

To specify the amount of memoryreservedfor editing a program online

Step 1. Make sure you are editing the program offline.

Step 2. Access the Program Properties. See “About Program Properties.”

Step 3. From the Program Info tab, enter the amount of bytes you want to

reserve for online changesin the Online Reserved Memoryfield. Enter

a value between 2048 bytes and 20480 bytes. The default amountis

4096 bytes.

Step 4. Click OK to accept the change.
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Appendix E

Rung Execution Order
In a ladder logic program, the rungs are executed from the top to the bottom.

Within a rung, instructions are executedleft to right until a branch is

encountered. Therefore, in a program without branches, the instructions are
executedleft to right in a rung, with thefirst rung being executed first and the

last rung executedlast.

Keepin mind that using JMP instructions within a ladder program changesthe

rung execution sequence. For more information about using the JMP and LBL
instructions, see the AutoMax Enhanced Ladder Language Reference manual,

J2-3094.

Using branching techniquesin a rung changes the sequencein which the
instructions are executed. Parallel branches are executed from the bottom up.

This meansthat the bottom branchis executed first and the top branchlast.

How branchesare executed arelisted below:

Branching technique #1:

Connecting contacts or block instructions acting as inputs in parallel (OR

condition)
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How the branchesare executed:

Howparallel branchesof input instructions execute depend upon whether:

e The relay input instructions use simple variables, bit—indexed integer,

double integer variables, or element—indexed array variables

e Blockinstructions are used in a parallel branch

This table summarizes how parallel branches of inputs are executed:
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If a parallel branch

contains:

Theinstructions are executed asfollows:

 

relay input instructions

using simple variables

The logic is executed starting at the last parallel

branch and going up the branchesuntil a true

row is encountered. Oncea true row is

encountered, any branches remaining above

the true branch will not be executed.
 

 
relay input instructions,

bit-indexed integer or

double integervariables, or

All parallel branches are executed, starting with

the last branch and working up the parallel

branches.

element-indexed array
variables   
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Branching technique #2:

Connecting a logical sequenceofinstructions composed of inputs and an

outputin parallel to a rung

d

 

a
m
l

“

 = 
Howthe branches are executed:

Parallel branches made up of a sequenceofinstructions composed of inputs

and an output are executed as follows:

e Eachbranchis fully executed before the main rung

e@ Multiple parallel branches are executed from the bottom up

Branching technique #3:

Connecting one or more coils parallel to a rung

p
™
~

3

 -—{ }

How the branchesare executed:

Parallel branches comprised of coils are executed as follows:

e Logic preceding the branched coil is executed, followed by the branched

coils. The bottom coil of the branch is executed first and the top coil of the

branchis executedlast.

e Once the branched coils have been executed, the remaining logic of the

main rung is executed.

Programming Techniques

The relay output instructions (coils) and the outputs of block instructions are set

whentheinstruction is executed. Therefore,if a variable is used as an input and

as an output within the same program, you can use a more recent valuefor the

input if the output instruction is executedfirst. For example, the variable motor_7



used on the NOI instruction will contain a more recent value, since motor_7 of

the coil is executedfirst. The motor_7 output is set upon execution.

 

  

ts! motor

Lf t { }
motor_l A o

1 | Li | { }

However, do not create a rung where the samevariable is used on an input and

an output, and the output is executedfirst. Creating such a rung results ina

verify error. The following figure shows such a rung:

 

 

 

 

 

 

The following figureillustrates how rungs and parallel branches are executed.
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13 Rung 1 is the First rung in the program to be executed.

a b c d

1 | 1 ft 1 | ~ —

2) Rung 2 75 the second rung to be executed.

& F

K++ }/——-__{ }

3) Rung 3 is executed next. Instuction i is executed first followed by g, if i
is not true. When 7 is true, g is skipped and coil h is then executed.

q h

1 | {} 

  
F

dit 

45 Rung 4 is executed fourth. The parallel branch comprised of instructions j, 1
and the GT instruction are all executed; the GT instruction is executed first,
followed by j and then 7
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5) Rung 5 15 executed next. This rung 75 an example of how you can use a
variable as an output in a parallel branch and then as an input to the branch
above. The ADD block is executed first followed by the MUL instruction. Since
output kk is updated after the ADD instruction executes, the newly updated value
qs used in the MUL instruction.
 

 

  

  

KUL
Out=Inl"Ine

EN ENG

XX Zz
_| int a

kek
_| Ine

ADD
Qut=Inl+In2+In3

EN ENG

pp lek
_| Ini a

rr
_| Ine

_| Ini   
6) Rung 6 is executed Tast. The instructions are executed in this order: y, 2,
Wy X, M, My On
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Appendix F

Converting Ladder Programs Created

Using an Older Version of AutoMax
You must convert any ladder program that was created using an AutoMax

Executive earlier than V4.X before you can edit it using the V4.X ladder editor

and the enhancedladderinstruction set. Once you convert the program, you
cannotuseit with an earlier PC editor.

You can convert ladder programs by doing any of the following:

e selecting a pre-V4.0 system from the System Configurator

@ copying a system, section rack or program

@ opening a program from the Editor

See “Opening Programs,” section 1.2.

The software prompts you to convert the system, which includes converting old

ladder programs. Any conversion warnings are postedin log file. If the
programsare converted when a system, section, or rack is converted, the

warningsare placedin the file UPDATE.LOG. If you convert an individual

program from the Editor, the warnings are placedin thefile program_name.LOG.
You can find UPDATE.LOGin the system directory, and program_name.LOGin

the rack directory.

At the dialog box prompting you to convert the program, choose Yes. The Editor

doesthe following:

e replaces the old ladderinstructions with the corresponding ones from the

enhancedladderinstruction set

e converts any remark sequencesinto a rung consisting of one coil

The coil names are those of the keywordsfrom the old remarks. These

new variables are local variables. The remark text becomes the rung
description for the new rung. Any tabs in the remark sequencesare

converted to single space characters.

e@ copies any variable description text to the new program and truncates the

text to 40 characters

e@ renumbers the rungs starting at number one

@ preserves any preset valuesfor timers and counters

e@ creates new timer and counter data structures by using the variable name

of the current timer or counter value as the name of the newtimer or

counterdata structure

The EN input of the new counterinstruction is connected to the powerrail.

e converts the task time (in seconds) to the equivalent numberof ticks as

defined for the Processor within which the program is slated to run

e deletes any descriptions associated with individually defined array

elements

These descriptions are not carried over to the converted program.

e converts shift instructions to a Shift Left Instruction. See ‘About How Shift

Instructions Are Converted into the Ladder Editor” in this Appendix.

To save the convertedfile, choose the Save command. If you quit the Editor or
close the converted program before saving the program,the original,

unconverted program is unchanged.
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The Editor createsa log file if any conversion error or warning messages are
generated. See “Correcting Ladder Program Conversion Warnings and Errors”

in this Appendix.

Once the Editor converts the program, it renamesthe original program file to
file.@PC and renamesthe original remarkfile.REM to file.@RE. You can delete

thesefiles later if you wish.

F.1 About HowShift Instructions Are

Converted into the Ladder Editor

Anyshift register instructions present in the old ladder program are converted to

a Shift Right (SR) instruction. The logic that drives the SHIFT and DATA

parameters is converted to correspond with the SRinstruction’s EN and BIT
parameters, respectively. The following table describes how other conditions are

handled.

 

 

If the: Then:

old instruction had a shift register The shift register length for the

length that is less than 16 corresponding SRinstruction is 16 (an
integer). Note that all the bits within the

integer are shifted. A message is posted

in the file UPDATE.LOG or
program_name.LOG.
 

RESETinput parameter was A MOVEblockis addedto the rung. This

programmedin the old instruction block is driven by the logic that was

connected to the RESET parameter.

The MOVEinstruction resets the shift

register integer when the reset coil is true.
   DATA and SHIFT parameters The rung is converted into a MOVE

were not programmedin the old instruction and a warning is posted in the

instruction file UPDATE.LOG or program_name.LOG.
 

 



F.2
Warnings and Errors
Correcting Ladder Program Conversion

This section lists some of the warning messages generated when you convert
an old ladder program to a V4.0 orlater program and describes what you can

do to fix them. The messagesare postedin the file UPDATE.LOG or

program_name.LOG.

 

Message: Whatthe message
means:

Resolution:

 

In old Rung numberxx
(new Rung numberxx),

the old global preset

variable is no longer used.

The variable assigned
to the PN parameterin

the old timer or

counterinstruction was
a global integer

variable.

To use a global
variable as a timer or

counterpreset, define

the timer or counter
data structure as a

global, double integer

array by using the
Variable Configurator.

For moreinformation

about preset values,
see “About Timer

Variables” and “About

CounterVariables.”
 
In old Rung numberxx
(new Rung numberxx),

the old global current

value variable is used.

The variable assigned
to the CN parameterin

the old timer or

counterinstruction was

a global integer
variable.

To use a global
variable to store a

timer’s or counter’s

current value, define

the timer or counter
data structure as a

global, double integer

array by using the
Variable Configurator.

For moreinformation

about current values,

see “About Timer
Variables” and “About

CounterVariables.”
 

In old Rung numberxx

(new Rung numberxx), a
preset variable is used that

wasalso used on another

rung.  In older ladder

programs, you could
use the samepreset

variable on multiple

timers or counters in
the same program.

Now, eachtimer or

counterinstruction in a

program must have a
unique data structure

assignedtoit.  To use the samepreset

variable on multiple
timers or counters, add

MOVEinstructions to

copy the preset value

from one of the
timer/counter data

structures to another

timer/counter data
structure.   
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Accept:

Appendix G

Glossary
To approvethe edit made to an online program. Rungs

that have been added, deleted, or modified must be

accepted and verified before they can be downloaded to

a Processor.

Bit-indexed variable: A variable referencing a bit within an integer

Commit:

or double integer variable. For example, pump.15

referencesbit 15 within the integer variable "pump.”

To allow the Editor to verify and download changes made

to an online program. You must accept online changes

before you can commit them. You can commit online

changes immediately after you accept them or while the

programis in Test Mode.

Data Structure: Data structures contain a collection of Boolean and

double integer data and are usedfor the timer and

counter data types.

Element-indexed variable: A variable referencing an element within

an array variable. For example, panel[11] references an

element 11 within the array variable "panel.” An element

can be a Boolean, integer, or double integer.

Global Variables: Global variables can be referenced by ladder,

Control Block, or BASIC programsin a rack. Global

variables can refer to memory locations, physical |/O

locations, or network locations. Global memory variables

can be of any data type supported by the Editor. If you

type in thefirst letter of a variable using upper case, the

default scope will be global. The namesof global

variables appearin upper case.

LocalVariables: Local variables are those that can only be used in

Match:

the program in which they are defined. No other

programscan reference them. If you typein the first letter

of a variable name using lower case, the default scope

will be local. The namesof local variables appear in lower

case.

As applied to the Resolve Variable Descriptions

command,a global variable in a ladder program that

uses the same name asonein Variable Configurator.

For example, the Editor would determine that a global

variable called PUMP_STATUSusedin a ladder program

is a match to a global variable called PUMP_STATUS

presentin the Variable Configurator.

The data type of a variable is not a factor when

determining whetherthe global variables match.
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Path:

Pause:

Program:

The directory structure used by the AutoMax Executive is:

drive:\library\system\rack

where:

 
drive is the personal computer hard drive where

the Executive is stored 
library is the base directory under whichall the

AutoMax systemsare stored 
system is the subdirectory where the system data-

basefiles are stored 
rack is the subdirectory whereall the rack data-

basefiles and all programsfor the rack are

stored    
The default drive andlibrary nameare specified as part of

the Setup procedurefor the AutoMax Programming

Executive software. If you want to create a newlibrary or

changethe default (selected)library or drive, you must

use the Setup procedure.

Places the Editor in the Paused state so that you can use

the Online Task Manager. The programs continue to run

in the Processor, but their display in a program window is

not updated.

Task. In the Editor, the terms “program” and “task” are

synonymous.

Rung status area: The gray-shaded arealeft of the powerrail.

Whenrung numbers,revision marks,or set triggers are

displayed, they are located here.

Test Mode: Lets you actively execute rungs, but the changes made

Trigger:

to the online program are not permanenily installed in the

processor.

A trigger is a way to capture orfreeze a rung’s status

while monitoring the program. Oncea triggeris set, the

rung’s status stays frozen on the programming terminal,

but the rung continues to run on the CPU.



A

AutoMax window, 1-1

Cc

Coil Off trigger, 5-14

Coil On trigger, 5-14

Commit command, 5-7

Constants, assigning to instruction

parameters, 2-10

D

Data display, 5-6

E

events, 1-8—1-9

G

Global variables, 2-14

Glossary, G-1

Instruction palettes

anchoring, A-5

moving, A-4

L

Local variables, 2-14

M

Monitor PC Program command,5-4

Index
P

Page breaks, 3-7

Page setup, defining, 3-5

Powerflow, 5-5

freezing or capturing, 5-13

Print options, setting, 3-4

Printing

defining page setup, 3-5

how Editor prints rungs, 3-6

multiple copies, 3-8
pagebreaks,3-7

components of printout, 3-2

range of rungs, 3-7

right-justifying coils, 3-8

setting print options, 3-4

Programs

closing, 1-3

converting older, F-1

data display in online, 5-6

displaying in multiple windows, 1-4

displaying in split window, 1-5

editing, 2-1

exiting the Editor, 1-8

editing multiple, 1-5

from the Editor, 1-6

from the Task Manager, 1-5

editing online, 5-1

accepting changes,5-6

cancelling changes,5-10

comparing with unedited program,
5-12

verifying changes, 5-11

changes you can make,5-1

downloading changes,5-7

memorylimits, D-1

open using Monitor PC Program, 5-4

pausing the Editor, 5-5

removing program, 5-10

saving in test mode,5-9
testing programs, 5-9

execution, 1-7

opening, 1-2

powerflow in online, 5-5

printing — see Printing, 3-1

properties, 1-7

running and stopping ladder, 1-8

saving, 1-3

saving automatically, 1-4

setting scan time, 1-7

states of online, 5-2

Index-1



verifying, 4-1 T

creating a verify error log file, 4-2

resolving errors, 4-3

variable configurator database, 4-2

warning messages, 4-3

Test mode, 5-9
removing online program from, 5-10

saving online program in, 5-9

Tick rate, 1-8

Toolbar, A-3, F-2
R anchoring, A-5

ladder language, A-2

. o, . moving, A-4
Run-timeerrors, viewing and clearing, standard, A-1

5-22 ,

RungErrortrigger, 5-15

Revision marks, displaying and hiding, 1-6

Triggers

clearing, 5-16

Rungtable, 3-3 re-activating, 5-15

setting, 5-13

Rungs waiting for while editing, 5-15
defining grid limits for, 2-2

entering descriptions of, 2-4

in the program window, 2-4

in the Rung Properties dialog box, V
2-4

inserting instructions into, 2-5 Variable nametable, 3-3
instructions Variabl

assigning variables or constantsto, arlaibies : .
2-40 assigning to instruction parameters,

2-10
changing data type of, 2-13

changing scopeof, 2-14

entering descriptions of, 2-11

forcing, 5-17, 5-19

unforcing, 5-20

list of set or forced, 5-21

pre-defined, C-1

error handling, C-2

ladder execution time, C-2

program scan, C-1

selecting, 2-13

set/force/unforce dialog box, 5-17, 5-21

setting, 5-17, 5-18

testing for forced, 5-22

total numberof forced, 5-21

S unforcing an entire page, 5-21

using Smart— Matching to enter, 2-12

Verify Error Log File, 4-2

Verify Errors, resolving, 4-3

changing type of, 2-9
using Find and Replace, 2-9

using Instruction Properties, 2-9

connecting

by drawing wires, 2-6

using ENO outputbit, 2-6

Properties dialog box, 2-8

selecting, 2-7

order of execution, E-1

printing of, 3-6
selecting, 2-2

starting, 2-1

turning the grid on and off, 2-2

Scan time, 1-8

Shortcuts, B-1

State of logic, capturing in an online

program, 5-13

based on coil becomingfalse, 5-14

based on coil becomingtrue, 5-14

based on rungerror, 5-15

Status Bar, A-5

Index-2
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